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Chapter 1. Wirecast™ Introduction
Welcome

Thank you for purchasing Wirecast.

This documentation is intended to help you not only understand how a particular feature of this software
operates, but to give you hints, tricks, and other information to help you make the best presentations
possible.

If you do nothing else, we strongly suggest that you first take the the section called “Getting Started” that
comes with the software. You can access the tutorial from the Help menu in the application. It should take
about 10 minutes and gives you a very brief overview of Wirecast.

After the Tutorial, we suggest reading the section the section called “Overview”. Just a few changes can
often make a huge difference in the quality of your presentations.

As with our software, we welcome comments, feedback, suggestions and the like. You can reach us at
<support@telestream.net>

Enjoy Wirecast and drop us a line when you've got a presentation you'd think we'd enjoy.

Registration

When you purchased Wirecast you were given a serial number. This serial number must be entered into
the registration area of Preferences.

Preferences can be found in the "Wirecast" menu. Or press Ctrl+, to open the preferences.

Enter your name and serial numbers. 

You should enter your name, exactly as you registered with us.

Also enter your serial numbers as provided by Telestream, Inc.

For more information. 

Please see the the section called “Register” documentation.

Getting Started

Wirecast uses some metaphors which are not commonplace in software packages available today.
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For this reason, we have integrated a Tutorial directly into the application.

The major difference between the Tutorial and this documentation is that the tutorial uses a narrative which
can show you the flow of using the application. This documentation cannot follow that style.

We strongly recommend that you take a few minutes to use the Tutorial.

The Tutorial is available from the "Help" menu:

• "Open Tutorial HTML"
opens your browser to the Wirecast tutorial

• "Create Document for Tutorial"
creates a Wirecast document with sample media already loaded for you.

Using this documentation. 

The screen shots used in this documentation were taken using the tutorial Wirecast document.

You can open this document by selecting "Create Document for Tutorial" from the "Help" menu.

Menu Documentation. 

Oftentimes, perusing the menus of an application can help ground you in the application.

If you are looking for information on a specific menu (or menu item), the documentation the section called
“Overview”.

Customer Support

Telestream is an online company -- we do all of our technical support through our website and email.

We highly value your feedback on our products, both positive and critical.

email contacts:

• Sales/Support: <support@telestream.net>

• Info: <info@telestream.net>

Website Links:

• Home: http://www.telestream.net

• Sales: http://www.telestream.net/purchase/store.htm

http://www.telestream.net
http://www.telestream.net/purchase/store.htm
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Chapter 2. Good presentations
Overview

There are a few very key elements to making a good presentation even better.
There are three things that you must always remember about video streaming:

• High quality audio input

Make sure you have the section called “Audio” A great looking video with poor audio input will sound
unprofessional.

• Good lighting

Make sure you have the section called “Lighting, lighting...”. Poor lighting can make an excellent look
horrible. If you are going to do chroma keying this may be the most important part of your setup.

• Always uses the best quality camera you have

Even if your viewers are going to see only 176x144 (G3 Mobile) an HDV camera is going to give you
much better quality than a USB camera.

Why is this?  When video is saved to disk or sent over the network, it needs to be compressed.

The compression process is done by encoders ("codecs") which are optimized to work with clean input
data.

This means that if the audio or video is muddy to start, it will be muddy after compression. Some codecs
may even highlight poor input because the algorithm is built to look for differences.

Your goal should be to give the best quality audio and video to the compression process as possible.

In Wirecast, this means to make sure that what you see in the the section called “Preview / Live” area is
the best you can make it look. Wirecast takes exactly what you see in that area and sends it to the codecs.

Lighting, lighting...

Do not underestimate the power of lighting. If you ever watch news footage being taped outdoors, you'll
notice that even then, they do the best they can to control the lighting.

A trip to your local hardware or art store will give you some excellent lighting options for both indoor and
outdoor settings at very reasonable prices.
For professionals, lighting is an artistic realm. Many people make their living controlling lighting, and a
few short paragraphs here cannot tell the whole story. However, these hints and suggestions can help a
first time webcasting team to get decent output.

• If using only one light, diffuse it

If you have only one lighting source, it should not shine directly on your subject. You should diffuse
the light.

• Avoid deep shadows

Make sure you "fill" all areas of your subject. Sometimes this will require adjusting the light to bounce
off a different wall, or by using two lights. Putting a light low and a light high is often a way to fill evenly.

• Don't light too evenly
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If you completely evenly light a set you may actually be worse off than not lighting the set at all. Look
at a sample shot and see if it "looks natural". Most productions will have a little more light coming from
above than any other direction. You should rarely light just from below the subject.

• Too much light

Be aware of having too much light for your subject. If your subjects are people, if you use a lot of light
you will need to use make-up to counter-act the lighting. This is not a bad thing, but you have to choose
how much effort you will go through to make a presentation. If your lighting balance is just right you can
get away without using make-up (or if you normally use make-up, then without having to use a base).

While adjusting the lighting, take a look at the subject and make sure they aren't washed out.

• Watch broadcasts and learn

Watch the News a few times with an eye towards "How are they lighting this" as opposed to listening
to the speech. You'll notice they handle all of the basics we cover here but you may catch something
that you'd like to add.

These "rules" sound rather vague and if you have one or two lights, you can get much better lighting. If
you are willing to invest a little bit more of your time and money in your lighting, we suggest that you
learn about what is called "Triangular Lighting" or "Three Light Setup".

Although this may sound complicated, it's actually quite simple, and involves setting up three lights (or
potentially using natural light as one of the lights), in a formula that gives you a good balance.

• Key light / Main light

This is the strongest of your lights, and does most of your work of lighting. This light normally comes
from one side of the camera (say, the left), and is a little raised. You could actually take a picture with
just the main light, but you'll see shadows.

• Fill Light (soft, directly in front of subject)

This is a very soft light which is simply to remove shadows and give the "fill" of the image. Is usually
direct (same level as the head of a person, for example), and usually comes from the same area as the
camera (or just to the side and behind). If you take a picture with just fill light, your subject will be way
too dark. It only adds to the main light to "fill in" the shadows.

If your Key light comes from the left of your camera, your fill light should come from the right, and
visa-versa.

• Back-light / Rim Light (directed from behind the subject and above)

This is the hardest light to explain, but it is the "accent" of your subject. If you look at high-school
yearbook pictures, you'll notice that the top-left (or top-right) part of all those head shots have a highlight
of light -- that is the back-light or "rim" light. It is also called "rim" light because it makes a slight rim
around the edge of the top part of the head of your subject.

This light normally comes from behind the subject, often from above, and is focused. Be sure it is not
directed at the camera.

Most serious lighting starts with these three basic lights. There are some great sites on the web that describe
these techniques in great detail. Here are some:

• http://www.paguk.com/lighting.htm

http://www.paguk.com/lighting.htm
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• http://www.diynet.com/diy/hp_cameras_equipment/article/0,2033,DIY_13955_2649634,00.html

Audio

Like video, audio is an art unto itself. However, you can make a great presentation even better by remem-
bering to focus on a few details.

Here is some common advice on producing clean audio.

• Use a good, external, microphone

Though this may sound obvious, a good microphone can make a the biggest difference. Most DV cam-
eras have audio-input for your microphone. Use it.

Most built in microphones are not good quality and will suffer from the hum of the electronics of the
"host" camera or computer. Even if it's not a great microphone, if it's external, it's probably going to
sound better.

• Consider a microphone splitter with two microphones

If you are doing an interview with one camera, you can use two microphones with a splitter ($5 from
Radio Shack). This often gives better results than one omni-directional microphone at a distance. You
can use "lapel" microphones with a splitter.

• Properly position the microphone

Position the microphone as close to the sound source as possible (even with omni-directional micro-
phones). Sound volume decreases rapidly over any distance, and the better levels (volume) you have
coming into the microphone, the better quality you will get.

• Consider investing in some "lapel" microphones

Even an inexpensive (less than US $20) lapel microphone can make a huge difference.

• Control environment noise

If a chair squeaks, use a different one. If you have a wood floor and you can hear people shuffling their
feet as they talk, put down a rug.

Broadcast Settings

Assuming you've got good video and audio coming into Wirecast, the last thing you need to do is make
sure you configure the best Broadcast Settings for your presentation. This, also, can be an art.

There are a lot of parameters to modify when dealing with broadcasts, but a few simple steps can help
get you on your way.

Bandwidth / Connection Speed. 

The first information you need to know is how much "bandwidth" you have at your disposal. This is how
much data you can send from your computer to your viewers computer. It depends on the speed of your
connection to the network and your viewers connection. In fact, it is the minimum speed between you
and all of your viewers. If you have one viewer who is using a dial-up modem, then for that viewer to see
good quality, you must broadcast at "Modem" speed.

So you have to know who your viewers are and what kind of connection they may have. This is a little
harder to determine. You have to ask yourself. Do you expect them to be connected to the internet modems
or DSL? Are they on your local network?

http://www.diynet.com/diy/hp_cameras_equipment/article/0,2033,DIY_13955_2649634,00.html
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In some situations, you are broadcasting for just your local network (say, in an office building). Here you
should discuss briefly with your network administrator your plans and verify that you will not disrupt the
network with your broadcasts. Ask them what your upper limit should be.

Your available bandwidth should be the minimum of what you can upload and what your viewers can
download.

Motion. 

Once you know your bandwidth, you need to decide whether your video will have a lot of "motion" or
not in it.

Motion means what you'd imagine -- how much things move around in the video. If you are doing an
interview, that is considered "low motion". If you are filming a basketball game, that is probably "High
Motion."

Putting it together. 

Wirecast comes configured with defaults to help ease your usage of Wirecast. You should pick the one
that matches the answers to the questions raised in the previews sections. See the section called “Encoder
Presets” for details on how to do this.

Older versions of QuickTime. 

If your viewers have older versions of QuickTime (version 5 for example), then you may wish to use a
different Encoder than the default. Many consider that the Sorenson 3 Codec for version 5 of QuickTime
is the best bang-for-your-buck.

Going Further. 

The parameters of the Encoders can be quite daunting and technical. It is beyond the scope of this document
to attempt to describe the delicate balance you must strive to achieve. There are folk who spend a lot of
their time fine-tuning encoders to attempt to get them to do exactly what they want. Wirecast comes with
what many consider the "generally optimal" settings for the various network environments.

See the section called “Overview” for information on changing the encoder settings.
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Chapter 3. Usage Patterns
Overview

Ways to use Wirecast. 

Wirecast was designed to support a variety of usage patterns (work-flow).

This section of the documentation is intended to show you alternative ways of using Wirecast that may
prove to be effective for your broadcast needs.

Two major usage patterns. 

There are, however, two major ways in which the application can be used:

• the section called “Presenter is Operator”

In this usage pattern, the person who is doing the presenting (speaking, etc), is the same person who is
using the application (the operator/engineer).

• the section called “Using an Engineer”

In this usage pattern, an engineer (or operator) is responsible for using Wirecast, and the presenter
concentrates on the content.

The presenter never needs to even know how Wirecast works.

Presenter is Operator

Definition. 

In this usage pattern, the person who is doing the presenting (speaking, etc), is the same person who is
using the application (the operator/engineer).

Suggestions. 

Below are a set of suggestions for using Wirecast when you are both the presenter and operator.

Be simple. 

When you are going to both interact with Wirecast and provide content (i.e., be the presenter), you should
set up Wirecast to make it as simple as possible for you to use while presenting.

Try to set up a "static" system -- set up your logo and titles in such a way that you don't have to change
much (if anything) during the presentation

Use only a few shots, so that it's easy for you to see which to click between.

Keep Auto-live on. 

So that you only have to do "one-click" keep the the section called “AutoLive and usage” on.

Pre-configure your shots. 

Make sure that all the shots you are going to use are created up front.

Use as few titles as possible. 
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Perhaps just use one title and use the the section called “Layers” to turn the title on and off instead of
trying to select different titles during runtime.

Use key-equivalents for switching shots. 

Wirecast has a hidden feature -- if your shot has a number in it, you may use option-[number] to imme-
diately bring that shot live.

So if you have a shot named "Me with title 1" and one called "iSight 2 No title", then pressing option-1
will bring "Me with Title 1" live and pressing "option-2" will bring "iSight 2 no title" live.

Using an Engineer

Definition. 

In this usage pattern, an engineer (or operator) is responsible for using Wirecast, and the presenter con-
centrates on the content.

Suggestions. 

Below are a set of suggestions for using Wirecast when you have both an engineer and an operator.

Keep AutoLive Off. 

As you may want to make several changes at one time before taking the changes live, you should probably
keep the section called “AutoLive and usage” off. The keyboard equivalent for the the section called
“Transitions / Time / Go ” (or Ctrl+G) is very handy when AutoLive is off.

Use shift-control-click. 

Holding down the shift and control key at the same time will temporarily toggle the AutoLive feature. It
will stay toggled for the length you hold down the keys.

This means that if you normally have AutoLive off (as suggested here), you can quickly make a shot
become live by holding down the shift-control keys and clicking on the shot.

Open the Preview window. 

You probably want to preview everything before it becomes live, so use the the section called “Preview /
Live” so you can see your setup before it becomes live.

Use the Layer windows. 

Under the "Window" menu, you'll find "New Layer Window". Use this to open secondary layer windows
so that you can quickly flip between shots on several layers.

Use the Inspector. 

Instead of double-clicking on shots to edit them, try using the Inspector.

This window acts exactly like the edit window but always edits the last shot you touched.

AutoLive and usage

Single-click vs Double-Click. 

Some users of Wirecast will want to "just click once" on a shot to make it become live.

Other users will want to make several changes to the broadcast before making them live.
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AutoLive is designed to allow both styles within Wirecast.

AutoLive only affects the main window. 

The AutoLive feature was designed to make a "one-click" interface possible for those users who wish to
simply click from shot to shot.

The Edit window (or other windows) are not affected by the status of AutoLive.

When AutoLive is on... 

• Just clicking on a shot in the main window will make it become "live".

• The the section called “Transitions / Time / Go ” becomes less useful.

• Shift-Control-Click makes load a shot into preview but does not make it live (see "Temporary Toggle"
below)

When AutoLive is off... 

• Just clicking on a shot in the main window will only load it in the Preview.

• The the section called “Transitions / Time / Go ” becomes imperative.

• Shift-Control-Click makes the clicked on shot immediately live (see "Temporary Toggle" below)

Temporary Toggle. 

Sometimes you may want to very temporarily toggle (turn on and off) the AutoLive state.

If you hold down the shift and control keys at the same time, AutoLive will temporarily toggle.

This enables you to very quickly switch AutoLive on and off for one action (say, a mouse-click).

Main Window Layout

Configuring your Main Window. 
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Wirecast was designed to be immediately usable with a few simple mouse clicks.

However, after you understand how Wirecast works, you may want more power at your fingertips.

Wirecast offers may ways for you to configure the windows to show you the information you desire when
you desire it.

Most of these features are available under the "Layout" menu in Wirecast.

Preview. 

Displays a the section called “Preview / Live” of what the broadcast will look like if you press the the
section called “Transitions / Time / Go ”. This is only really useful if AutoLive is off.

Layer Visibility. 

Shows the set of visibility buttons just underneath the preview and Live.

Clicking on these buttons quickly turns on/off visibility for the particular the section called “Layers”.

Master Audio. 
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This area allows you to control the output master volume level, master mute, and line-out mute.

controls the master mute of the audio (what your viewers hear). note that even when you have muted the
output, the Encoder will still generate audio (though it will be "blank"). If you want to never broadcast
audio, you should modify the the section called “Overview” to not push audio through the encoder.

controls the line-out mute (what you hear). Even when the headphones are mute, your viewers will still
hear the output, it's just not sent to your headphones (or speakers).

Main Shot List. 

Normally, the main window shows the shot list at the bottom of the window. However, you can turn this
off, as shown below:

This is useful if you want to open up separate Layer windows (see below).

Here is a the section called “Layers”.
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Output Statistics. 

These are the statistics that are available about your broadcast.

Note
When you are not broadcasting, these statistics are not displayed

• FPS - Frames Per Second

The video part of your currently selected the section called “Overview” controls this value, but note that
most encoders treat this as a hint. This means the values you will find in usage will be near the value
you have selected in the encoder preset.

If this value is consistently dropping well below your target FPS, consider not using the section called
“Advanced”.

• CPU - CPU Usage (percentage)

This shows the current strain on your CPU. If this value is high, you may consider using a different
encoder, or modifying your encoder settings. The encoder affects your CPU usage more than any other
parameter in Wirecast.

If the CPU usage is nearing 95%, you may consider not using the section called “Advanced”.

• Datarate - How much network bandwidth your broadcast is using.

This shows the current bandwidth of your broadcast. The video part of your currently selected the section
called “Overview” controls this value, but, like Frames Per Second, is not always respected by the
Encoder. The Encoder uses this value as a hint, not an exact limit. Some Encoders will purposefully
go over this limit in some instances.

• Time - How long you have been broadcasting.

This value does not reset when you start/stop the broadcast -- it is cumulative. This allows you to be
able to save pieces of a broadcast to disk and know the total amount.

In this example, the presentation has been broadcasting for 5 minutes and 3 seconds.

Layer Panel. 

This opens and closes the the section called “Layers” in the lower left of the main window.

You can also slide this panel open by moving the knob to the right.

Here is what the main window looks like with the Layer panel open (see lower left):
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Edit Window Layout

Editor Preview. 

In the "Layout" menu, the menu item "Editor Preview" will hide/show the preview at the top of the editor
window. This also works for the Inspector.

This can be useful if you have a smaller monitor.

Here is what the Editor looks like without a Preview:

Showing just the preview. 

Using disclosure button (
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-- middle left of shot editor window) allows you to show just the preview.

Here is what the Editor looks like with only a Preview:

Information on Shot Editing. 

More information about editing shots the section called “Overview”.

Layer Windows

Multiple Layer Windows. 

The bottom part of the main window (the shot list) can be opened in a separate window.

Under the "Window" menu, the menu item "New Layer Window" shows the windows you can open.

Here is what one of the Title Layer window looks like:

This area works exactly as the shot area in the main window. You can even change which layer is being dis-
played. To do so, just open the layer panel and select another layer. Here, we've selected the "Foreground":
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Layer Documentation. 

Here is more information about the section called “Layers”.
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Chapter 4. Hardware
Overview

This chapter describes hardware related constraints, issues, and features.

These sections cover specific hardware issues and restrictions:

• the section called “FireWire (IEEE 1394)” -- issues related to IEEE 1394 devices

• the section called “DV Cameras” -- a Restriction with DV cameras

• the section called “Sleeping” -- Sleeping your computer

• the section called “S-Video / 2nd Display” -- How to show Wirecast output on a second device.

• the section called “Configure Devices” -- How to set up your camera / input device

FireWire (IEEE 1394)

FireWire (IEEE 1394). 

FireWire is a hardware protocol that you may use to connect devices (cameras, hard drives) to your com-
puter.

It's important to understand that saturating (using up all available bandwidth) your FireWire bus will lead
to problems in Wirecast, as the audio and video will appear choppy.

FireWire Saturation. 

There is an absolute limit to the bandwidth available to your FireWire devices (400 or 800 megabits per
second).

If you use a FireWire hub and plug several devices into that hub, you will share the bandwidth on that
FireWire bus. Adding a hub does not add any bandwidth to the bus, just more places to plug things in.

If the sum of your devices goes over the speed limit, you "saturate" (use up) the available bandwidth.

If you have a camera attached to the FireWire bus and you saturate the bus, then you will see dropped
frames (choppy video).

Devices do not always use all bandwidth. 

If you have a hard disk connected to a FireWire hub and also have your camera connected to the same
hub, it may appear to work. You're using the camera just fine!

Unfortunately, this may not be a good indication of whether the bus will ever become saturated. For ex-
ample, email could arrive and your email program could access a file on your FireWire drive which causes
FireWire saturation.

The lesson to learn is this: Be careful when connecting hardware to your machine. Just because your setup
works once when you first put it together in does not mean it will always work. Play with your setup and
make sure that you have enough FireWire bandwidth to share all of your devices without experiencing
choppy video.

Some Devices, especially cameras, request more bandwidth than actually required. 
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Normally, a camera requires around 25 Megabits/second to deliver audio and video to Wirecast.

Unfortunately some cameras actually allocate 100 megabits / second (or more!).

High Definition (HDV)

High Definition Video. 

Wirecast is the only webcasting system that can use HDV cameras in HDV mode. Although you can
achieve extremely high quality video using HDV, there are some limitations to using them, mostly due
to the resources they consume.

One Camera per bus. 

When your camera is in HDV mode, you will only be able to have one camera per bus.

Two HDV total, and only on higher end hardware. 

You will need a high end computer if you want to use more than one HDV camera with Wirecast. HDV
images are so large that they will stress all components that are involved in your production: memory,
video memory, video fill rate, bandwidth (on input busses) and so forth.

If you want to use several cameras, and only have HDV cameras on hand you may consider using your
secondary cameras in DV mode.

HDV cameras in DV mode. 

If you switch your HDV camera to DV mode, your camera will act like a DV camera.

Although you won't get HDV quality, you will get much higher quality than your average DV camera, as
most HDV cameras have very high quality CCDs int hem.

DV Cameras

One Camera Per Bus. 

We recommend that you use only one DV camera per 1394 card.

If you do this, you should not have any conflicts or saturation problems with your cameras.

But if having more than two cameras won't saturate an 800 mbits/sec, why the 2 camera restric-
tion? 

You may be able to get away with more having more cameras per bus.

It mostly depends on the cameras that you use. Some cameras, even relatively recent models, do not behave
properly with regard to using multiple cameras on the same bus.

If your cameras behave correctly with regard to the FireWire bus, then you may be able to use more
cameras per bus / card. See below for a discussion on "How cameras conflict on 1394".

The upshot is that it may be possible, but due to the hardware limitations, we cannot recommend it.

How cameras conflict on 1394. 

Although the specific details are more complicated than described herein, the problem is basically this:

Each camera is required to negotiate the channel on the FireWire bus that it will transmit on.
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However, some cameras (or more specifically: firmware in those cameras), either do not negotiate at all
or ignore the results of the negotiation and transmit on a predetermined channel.

As one might expect, this causes a lot of problems on the receiving end (in Wirecast), as data coming into
Wirecast on one channel is actually coming from two devices.

There is nothing Wirecast can do in this situation, and it is widely acknowledged to be a problem with
older or very inexpensive cameras.

Sometimes I can use two cameras on the same FireWire bus just fine, sometimes I can't. What's
wrong? 

The most unfortunate part is that the cameras that fail do not fail consistently.

This has to do with the fact that some cameras appear to "randomly" pick a channel to transmit on. So
sometimes it will work and sometimes it will not.

Sleeping

Putting your display to sleep. 

When put your display to sleep, it turns off the video card. Wirecast uses your video card as part of
broadcasting.

Wirecast automatically tells the operating system to not put your display to sleep (it tells the computer it's
"busy"), so that this will not happen accidentally.

However, if you forcibly put your display to sleep, your broadcast will stop.

S-Video / 2nd Display

External Display Output. 

S-Video out and 2nd Display has not yet been implemented for the Windows version of Wirecast.

This feature will be available in a future release of Wirecast.

Configure Devices

Configure Devices. 

Some devices (cameras, etc) may be able to be configured.

Choose the device you wish to configure from "Configure Devices" in the the section called “Media” menu.

Note
The configuration user interface is provided by the device maker. It is beyond the scope of this
document to describe all of the features available for all devices. See the documentation provided
with your device on how to configure it.

Device Manager

Device Manager. 

The device manaager window allows you to define which devices (cameras, mics, etc) are loaded by
Wirecast on launch.
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If the checkbox is ticked, then the device will be loaded, otherwise it will not be loaded.

This is a global action - it affects all documents loaded by Wirecast.

With some devices, you might unchecked all of the input channels except for one to allow Wirecast to
load only that channel.
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Chapter 5. Media Capabilities
Overview

Overview. 

In addition to live video from your cameras, Wirecast allows you to work with media that you have created
outside of Wirecast.

This section introduces some other common media that you may wish to use with Wirecast.

There are three ways to add media to Wirecast:

• To make the media a shot - Drag & Drop
If you want to make the media its own shot, then the simplest way is to drag the media directly on the
the section called “Shot Selection Area”.

• To add the media as part of an existing shot - Drag & Drop
If you want to make the media its own shot, then the simplest way is to drag the media directly on the
the section called “Overview”.

• To add the media as part of an existing shot - Add Button
Alternatively, you can press the "+" button in the the section called “Overview”.

Media capabilities. 

The rest of this chapter is dedicated to information about specific types of media that Wirecast supports.

Images / Opacity

Images / Opacity. 

Wirecast supports a wide variety of still images types (TIFF, GIF, JPEG, PNG, etc).

Some of these formats (TIFF, GIF, PNG, etc) offer some form of Opacity or Transparency. This is often
called an "Alpha" channel.

Wirecast will work seamlessly with these formats and is the preferred method for using graphics such as
Logo's which have transparency.

GIF and Transparency. 

However, GIF files are a special case because they only offer Transparency, not true Opacity. (the GIF
format allows you to say that part of the image is transparent (completely invisible), but does not allow
you to say that part of the image is "partially transparent").

Some GIF images use Transparency for much of the image. However, near the edges of the visible data,
Transparency cannot be used. Often this happens when there is a shadow near the edges of the visible
data. The author of the GIF often assumes a certain background color (white, for example) and that color
becomes embedded in the actual image.

When Wirecast displays these types of images, the edges of the visible data will show the "background"
that was saved in the GIF. This is not a defect in Wirecast; Wirecast is properly representing the data as
it was saved in the GIF.
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The solution to this is to obtain the original image (for example, the original Photoshop file), and re-save
the image as either TIFF or PNG. Both of these formats offer full Opacity.

Movies

Movies. 

Wirecast supports a wide variety of movie formats (MOV, AVI, WMV, etc).

Sometimes, however, you need to install a "codec" to use these formats. (A very commonly desired one
is DivX®).

Wirecast will inform you if a codec is missing or if you need to install one. It is beyond the scope of this
documentation to describe all of the possible codecs available on the market today or explain the intricacies
of installing each.

Contact the provider of the codec for details on installing for your usage.

Wirecast won't show my movie of type XYZ. 

Although there's always the chance that Wirecast is at fault, before contacting technical support, please
try to open the media with QuickTime player and/or Windows Media Player. If these players cannot open
the file, then most likely the codec is not properly installed (or there is no available codec for the media).

Please note that Wirecast does not currently support some file formats (.mpg, .mpeg, .m1v, .m2v).

The workaround is to convert the media into a different type (such as MPEG-4).

MPEG, MPG, M1V, M2V

MPEG, MPG, M1V, M2V files are Unsupported. 

These file types are currently unsupported by Wirecast.

Workaround. 

The work around is to convert the media into a different type (such as MPEG-4).

AVI

Video may not play. 

Some AVI files may not play the video (the audio will play however).

Workaround. 

The work around is to convert the media into a different type (such as MPEG-4).

Real Media

Unsupported. 

Real Media Files (.RM) are not supported by Wirecast.

Workaround. 

The work around is to convert the media into a different type (such as MPEG-4).
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Chapter 6. Titling Capabilities
Overview

Wirecast offers a wide variety of Title templates for you to use in your broadcast.

Adding a professional looking title is as simple as selecting a template and adding your text.

To learn how to add a title to a shot, see the section called “Adding Titles to Shots”

To learn how to modify parts of a title, see the section called “Modifying Titles”.

Adding Titles to Shots

From the main window, double click on a Shot (Here, we are double clicking on "Ripples" from the the
section called “Getting Started” document).

The following window will open:
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Notice in the bottom left area of the window, you'll see "Title", "Foreground", etc. These are the various
configurable elements in a shot. For more information on this, please see the section called “Shot Ele-
ments”.

Currently, "Scene" is selected. If you click on the text "Title" it will become selected (and checked).

The checkbox tells you whether the element is visible, and Wirecast will make the shot element visible
when you first click on it. So clicking on the "Title" will both make it visible and show you the title options:



Titling Capabilities

Wirecast 24 Telestream, Inc.

Notice that Wirecast has selected a template by default for you.

You are now ready to modify the title. See these the section called “Modifying Titles” for more details.

Modifying Titles

To modify the titles, you have to first the section called “Overview”, and select "Title" from the the section
called “Shot Elements” list.

You modify settings in this area of the screen:

Title area overview. 

There are two main sections here:
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• the top / text entry area -- Configuration of the text, justification, font and font color.

• the bottom / icon area  -- Area where you can the section called “Choosing a Template”.

You have the ability to modify 3 lines of information, and the settings are arranged horizontally to associate
the line of text with its own settings (Justification, Font and Font Color).

Here is what "Line 1" looks like:

Changing Text. 

To changing the text, you simply enter the text into the text entry area for "Line 1"

Wirecast supports all text entry (even in-line entry engines for Japanese, Korean, Chinese, etc).

Changing the justification. 

Justification is control via a popup just to the right of the "Line" and looks like this:

.

Simply click on the icon and select the justification method.

Changing the font. 

Press the

button to change the font. A Window will appear to change the font. If you press the

again, the panel will disappear.

This floating palette also watches which text-input you have selected. So if you click in a different text
entry area, the font panel will notice this and configure itself to the settings of the new text entry area.

Note
The only items that Wirecast recognizes in the Font Panel are: "Font Family", "Typeface", and
"Size". All other settings are ignored by Wirecast

Changing the Font Color. 

Press the

button to change the font color. A standard color picking window will appear to change the color.

Choose the color you desire and press "OK".

Choosing a Template

Title templates are shown at the bottom of the Title window, which looks like this:
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Click to Choose. 

Simply click on an icon to choose a different template

Information that is stored in a Template. 

Templates store this information:

• General Layout (images, where text appears, etc)

• Font Justification

• Font (the actual font to use)

• Font Color (color of the font)

• Background Color

• Background Opacity

As you switch templates, all of your changes are replaced with what exists in the template.

The exception is that any text you have entered not modified (as the template carries no default text).

Where to put Titles

Where to put Titles. 

The previous sections of this chapter describe how to edit a title for a shot.

The example showed putting a title "on top of" an existing shot.

However, as our the section called “Getting Started” shows, you can also create a shot which has only
title data.

This is very useful if you want to overlay the same title over the top of several shots, or if you want to
modify the title independent of which shot you are choosing.

The choice is up to you. 

This means you have an artistic choice.
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You must decide for your broadcast if you want your titles to be tied directly to specific shots or if you
want them to be independent.

Wirecast seamlessly supports using both methods - and even both methods at the same time.

Example: Seminar Title. 

You may wish to broadcast a seminar and have the title of the seminar appear and disappear from time to
time. But you have several other shots (perhaps cameras) you are switching between.

In this case, you'd probably create a shot which has only a Title in it. You could move this title to the
Foreground layer (see the section called “Layers” for more details on layers and moving shots between
layers).

In this configuration, you can bring the title in and out of your broadcast by selecting it in the Title Layer.
And this is all independent of the other shots you may have created and are in use.

Example: Interviewee Title. 

If you are broadcasting an interview, a shot which contains the camera for the Interviewee may have a
title in it.

In this case, when you cut to the shot of just the interviewee, the title will appear. When you cut to the
person asking the questions, the title will not appear because it is a different Wirecast shot.

Note
Since you can turn visibility of a title on and off inside the shot editor, you can still turn the title
on and off on the shot. To do this, make the shot live, then open the shot editor. Turn the Title
checkbox on, press Go (or command-G). Turn the Title checkbox off, press Go.

Creating New Templates

Not supported using Wirecast user interface. 

The templates that Wirecast uses are not edit-able within Wirecast.

A no user interface solution. 

Despite a user interface not existing for templates, you may create new ones yourself.

Wirecast looks in your "My Documents" directory for a directory called "WirecastTitles". It is here you
can put your own titles.

Examples. 

An example WirecastTitles directory exists on our server: http://www.telestream.net/downloads/wire-
cast/titles/WirecastTitles.zip

Simply download and put the uncompressed "WirecastTitles" directory into your "My Documents" direc-
tory.

The next time you launch Wirecast, user titles will be available.

Getting oriented. 

There is an XML file called "description.xml" which describes all of your Titles.

You edit this file to add/create/delete your Titles.

http://www.telestream.net/downloads/wirecast/titles/WirecastTitles.zip
http://www.telestream.net/downloads/wirecast/titles/WirecastTitles.zip
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Other Media. 

Any media used by these templates must exist in the same folder. For example, we use
"user_scoreboard.png" in one of the example templates and that is included in the Wirecast_User_Titles
directory.

Editing the XML file. 

Please read the header of the XML file for a list of rules and descriptions.

Make backups of this file before editing as simple syntax errors will cause Wirecast to not parse the file.
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Chapter 7. Logo Capabilities
Overview

When you perform a broadcast, you may wish to include a Company logo in your presentation.

There are two ways you can do this in Wirecast, and it depends on how you wish to use Wirecast.

• Logo is its own shot
In this configuration, you create a shot which only has the logo in it.

The benefit of this configuration is that you can show the logo independently of all other shots. For
example, you can choose to always show the logo (for example, in a corner of your broadcast).

See the section called “Global Logo” for details on accomplishing this.

• Logo is part of another shot.
In this configuration, you add a logo to an existing shot.

This is if you want to have, for example, a shot you'll use as part of the start of your broadcast.

See the section called “Global Logo” for details on accomplishing this.

 

Global Logo

Global Logo. 

Logos always exist in Shots.

In fact, Wirecast treats logos exactly the same way any other static media is treated.

A 'Global Logo' is just a shot that contains only your logo. 

To create one, you simply create a new, empty, shot and add your company logo to it.

Step-by-step directions. 

• Go to the Foreground Layer

In the main window, slide open the panel on the lower left (or select "Layer Panel" from the "Layout"
menu).

Click on the text that says "Foreground", and your window should look like this:
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• Add an new shot

In the main window, press the

button. You'll find it in the bottom left hand part of the window shown above.

Your window should look like this:

• Edit the New Shot

Double click on the shot named "New Shot".

Your window should look like this:



Logo Capabilities

Wirecast 31 Telestream, Inc.

• Add your logo

You can drag and drop your logo to the list shown at the bottom, or you can use the

button.

In this example, we'll just selected "logo.png", and we get the following in the preview at the top of
the edit window:

• Position your Logo
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Most likely, you won't want the Logo directly in the middle, so to position it, you need to select "Posi-
tion" from the tab in the middle of the edit window, as shown below. Below, we have positioned the
logo to the top-left, and doubled it in size.

• Move Media -- Use the mouse in the Preview area.

• Resize Respect Aspect -- Hold the Alt key while moving the mouse in the Preview area.

• Resize Media -- Turn off the section called “Respect Aspect Ratio”. Hold the shift-Alt keys while
moving the mouse in the Preview area.

• Rotate Media -- Hold the control key while moving the mouse in the Preview area.

• Select your Logo for the Broadcast

Close the edit window, and select the shot in the "Foreground" Layer:
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• Change shots on the Normal layer

Go back to the Normal layer by selecting "Normal" on the left side of the window as shown below.

You can see that changing shots on the Normal layer does not affect the Logo you have put on the
Foreground.
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• Usage pattern hint: Turn off Foreground Layer

One way that you can use Wirecast is to turn on and off layers.

In this case, we can turn off the (and turn back on) the Foreground layer by clicking on the icon next
to the world "Foreground", as shown below.

This very powerful way of using Wirecast allows you to have a Logo (or other graphic) on stand-by
in another layer, ready to go.
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Shot Logo

Shot Logo. 

Logos always exist in Shots.

In fact, Wirecast treats logos exactly the same way any other static media is treated.

A 'Shot Logo' is just a shot with your logo in it. 

To create one, you simply take an existing shot and add your company logo to it.

Step-by-step directions. 

• Double click on a shot

Here we pick the shot "Ripples" from our tutorial. (You can open the tutorial by selecting "Create
Document from Tutorial" from the Help menu).
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• Select the Foreground shot element

After double-clicking, click on the "Foreground" text in the bottom left of the screen. Your window
should look like this:
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• Add your logo

You can drag and drop your logo to the list shown at the bottom, or you can use the

button.

In this example, we'll just selected "logo.png", and we get the following in the preview at the top of
the edit window:

• Position your Logo
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Most likely, you won't want the Logo directly in the middle, so to position it, you need to select "Posi-
tion" from the tab in the middle of the edit window, as shown below. Below, we have positioned the
logo to the top-left, and doubled it in size.

• Move Media -- Use the mouse in the Preview area.

• Resize Respect Aspect -- Hold the Alt key while moving the mouse in the Preview area.

• Resize Media -- Turn off the section called “Respect Aspect Ratio”. Hold the shift-Alt keys while
moving the mouse in the Preview area.

• Rotate Media -- Hold the control key while moving the mouse in the Preview area.

• Select between shots in the Main Window

Close the edit window, and click on the River logo (or use the Go button) to make your changes live.

You'll notice that the River now has the logo embedded in the shot:
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• Change shots on the Normal layer

Notice that when you change to another shot, the "logo" disappears.

This is because the logo is embedded in the shot.

In fact, you could define the logo to have the section called “Overview” and when you change shots,
the logo would behave accordingly.
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Chapter 8. Broadcasting
Overview

Before you can broadcast with Wirecast, you must configure your broadcast settings.

After you have configured the broadcast settings, broadcasting is as simple as selected the "Start Broadcast"
from the "Broadcast" menu (or Ctrl+B).

If you try to broadcast without first configuring, Wirecast will open the Broadcast Settings window.

The "Broadcast Settings" window is available from the "Broadcast" menu in Wirecast (or Ctrl+Y), and
looks like this:

There are three main sections to this window:

Multiple broadcast settings. 

Wirecast allows you to specify many broadcast settings for your presentation.

This means you may configure Wirecast to, for example, broadcast two different bit-rates to your viewers
(e.g., one for modem, one for DSL). Or you may record to disk with different encoders.

You can even broadcast QuickTime and Windows Media 9 and Windows Media 8 all at the same time,
if you have enough CPU to perform the real-time encoding.

The top of the broadcast settings window is a list of the current settings you have configured.

The checkbox in this list defines whether that particular broadcast setting will be used.

You may add as many broadcast settings as you wish, however, be aware that encoding video is very
CPU intensive, and the higher quality settings you choose, the more CPU the encoder (codec) will need
to honor your settings.

The Gear icon holds actions that help you by creating reference movies you can distribute to your viewers.
See each Destination section for details on what the each Action menu does.
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There are two main things you need to configure when broadcasting.

Encoder Preset. 

The Encoder Preset defines how your presentation is "encoded" or "compressed". There are a myriad of
options available, but Wirecast simplifies this process by providing several simple presets to choose from.

See the section called “Encoder Presets” for details.

Broadcast Destinations. 

When you broadcast with Wirecast, you must broadcast to a specific destination. A destination could be
the disk (Record to Disk), or a server.

Each encoding preset uses a different broadcast technology (QuickTime, Windows Media, etc).

The destinations described below depend on the technology in the Encoder Preset you have chosen.

Broadcast with Windows Media destination. 

There are two destinations offered with Windows Media:

• Network
The stream will be broadcast over the network, either using a Windows Media server or using your
local machine as the server.

To use a Windows Media server, you need to use the the section called “WM - Push To Server” option.

To use a your machine as a server, you need to use the the section called “WM - Pull from Server” option.

• Record to Disk
You may also record your presentation to disk. You can do this whether you are broadcasting to another
machine or not.

See the section called “Record to disk” for details.

Broadcast with QuickTime destination. 

There are four destinations offered with QuickTime:

• QuickTime/Darwin Streaming Server
The QuickTime Streaming Server (or Darwin Streaming Server) resides on a second computer and acts
as what is called a "reflector". From within Wirecast, you send your broadcast to this one server and it,
in turn, sends the broadcast to the many viewers that you have.

You must use the QuickTime/Darwin Streaming Server if you want to broadcast a QuickTime stream
live to multiple viewers.

See the section called “QT - Streaming Server” for details.

Note
If you want to archive your stream at the same time, add a second broadcast setting and use
"Record To Disk" for that setting.

• One second specific Computer.
You can configure Wirecast to send a broadcast to a single second machine. This is called "Unicasting".
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See the section called “QT - Unicast” for details.

• All computers on your local network
You can configure Wirecast to broadcast on your local network such that any computer on your local
network can listen to the broadcast. This is called "Multicasting".

You cannot Multicast to the Internet, only to the local network on which your machine resides.

See the section called “QT - Multicast” for details.

• Record to Disk
You may also record your presentation to disk. You can do this whether you are broadcasting to another
machine or not.

See the section called “Record to disk” for details.

Encoder Presets

The Encoder Preset popup is found in the middle of the Broadcast Window:

Wirecast offers several presets by default.

See the section called “Broadcast Settings” in the Good Presentations chapter for details on selecting a
good encoder.

The first choice you need to make is whether you'll be using Windows Media or QuickTime (or both) as
the broadcasting technology.

This decision mostly depends on what you expect your viewers will want to view the stream with.

Given enough bandwidth, you can stream to both QuickTime and Windows Media by selecting adding
to broadcast settings.

Windows Media Settings. 
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With Windows media the first choice you need to make is whether you will use Windows Media 8 or
Windows Media 9.

Again, this choice depends on what you expect the minimum spec to be for your users.

If your CPU can encode both in real time, you can choose to broadcast both Windows Media 8 and Win-
dows Media 9 at the same time.

See ??? for details on how to choose the amount of bandwidth for Windows Media.

QuickTime Settings. 

In its simplest form, you need to choose the minimum connection speed your viewers (or you) will have.
If you or any of your viewers will have a modem, you should choose one of the modem. If all of you have
at least DSL or cable, then you can choose a higher speed.

Motion simply means whether your broadcast will have a lot of motion in it or not. If you're doing an
interview, then most likely its going to be Low Motion. If you are broadcasting jugglers, High Motion
is your ticket.

• Modem
For use when you or your viewers have only a modem connection.

• DSL / Cable
When you and all your viewers have at least a DSL or Cable connection.

• LAN
For use in a company/school environment when all of your viewers are on the same LAN as you.

If you are going to only Record To Disk and your viewers will download the file from your server, then
you may choose to encode for "LAN" as well. You can do this because your viewers are not trying to
download the file in real-time.

WM - Push To Server

How to access. 

To access this window, select "Broadcast Settings" from the "Broadcast" menu (or Ctrl+Y).
Then, from the "Encoder Preset" popup, select any of the "Windows Media" based presets, and check the
"Push to Server" checkbox.

Push to Server usage. 

To use this Push To Server, you must have access to a Windows Media Server, either in your organization
or housed by an ISP (search the internet for "Streaming Windows Media Server").

This is the "industrial strength" way of creating a stream as it puts the bandwidth strain on the remote
server. All you need is a good local connection to the internet to push to the Windows Media Server.

Configuration. 
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• Address
The internet address of the Windows Media Server you will use to broadcast.

• Publish Point
The name of the file that will be put on the server, and that will be used as part of the URL that your
users will use.

Wirecast cannot know the resulting URL that your users will use, as this may vary depending on the
installation of the Windows Media Server. Contact your Windows Media Server administrator to un-
derstand how to build a proper URL for your viewers, given the Publish Point.

• Auto Remove
If you check this checkbox, the file used as the publish point will be removed when the broadcast is over.

• Username / Password
The user name and password for the Windows Media Server. Contact your Windows Media Server
administrator for this.

If there is no user name/password required, leave these field empty.

WM - Pull from Server

How to access. 

To access this window, select "Broadcast Settings" from the "Broadcast" menu (or Ctrl+Y).
Then, from the "Encoder Preset" popup, select any of the "Windows Media" based presets, and check the
"Pull from Server" checkbox.

Pull from Server usage. 

This option turns your local computer into a mini Windows Media Server -- you can broadcast immedi-
ately.

Although very useful for some scenarios, there are some caveats:

• Maximum 50 users - You cannot have more than 50 connected users
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• Bandwidth - You must have enough bandwidth between the machine Wirecast is on and all of your
viewers.

• CPU - The machine is acting as a server and to that extent, some CPU is used per connection (though
not much).

The largest issue is with using this method is bandwidth. If, for example, all of your viewers are on a local
network (a business or school), then you should be able to use this method.

If you have a DSL connection to the internet and you want to broadcast a 200k stream to 20 viewers, you
will simply not have enough upload bandwidth to accommodate this.

Note
Be aware that when you use Wirecast with an internet connection what matters is your upload
bandwidth. Most ISP businesses offer packages that have a higher download than upload band-
width (e.g., a 512k DSL package is often only 256k upload).

Configuration. 

To use this option, simply set the port number that your users will use to connect to your machine. They
will connect to your machine by using the "Open URL" option in Windows Media Player, and enter an
URL like this: mms://192.168.1.67:8080 (assuming your machine's IP address is 192.168.1.67 and the
port you set below is 8080).

Note
The URL "mms://" does not work with the Macintosh version of Windows Media Player, and
you must use "http://" instead.

• Port Number
The port on your machine to use as the broadcast port.

This can be, effectively, any port number as long as it doesn't conflict with any existing ports on your
computer.
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Note
Be aware that if you have any Firewall software installed, you will need to enable the port
entered here.

• Maximum Connections
This is the maximum connections your server will accept.

There is a hard maximum of 50 users.

Your CPU will be somewhat affected by the number of users that you have connected, and it is for this
reason you may wish to limit the number of connections.

QT - Streaming Server

Apple's QuickTime Streaming Server runs on Macintosh Hardware. The Darwin Streaming Server is the
open source streaming server offered by Apple, and runs on many flavors of Unix (OpenBSD, Linux, etc).

Streaming Servers act as "reflectors". So your goal is to broadcast from Wirecast directly to one of these
servers. That server then sends the stream on to your viewers. This document does not describe configuring
or maintaining QuickTime / Darwin Streaming Server.

To stream to a QuickTime / Darwin Streaming Server, you need to select the Destination of "Announce
to QuickTime Streaming Server", as shown below:

Destination. 

To send to the QuickTime / Darwin Streaming Server, you must have "Announce to QuickTime Streaming
server" selected in the Destination popup.

Host Name. 

This is the name (or IP address) of the host computer that your Streaming Server is running.

File Location. 

The Streaming Server uses a file on the server to contain the specific settings for the stream. You need to
define the name of that file here. When you send your viewers the URL to use, this file name will be a part
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of that URL. for example, if the File Location is "my_stream" and the Host Name is "www.stream.com"
then your viewers will need to use this URL: "rtsp://www.stream.com/my_stream.sdp". This information
is shown in the bottom of the window as you configure the settings.

Username. 

If your Streaming Server requires it, this is the user name to use.

Password. 

If your Streaming Server requires it, this is the password that is sent.

Note
This password is saved as plain-text in the Wirecast document.

Broadcast over TCP. 

Defines whether you are using UDP or TCP to send the data to the Streaming Server. This only defines
the connection between Wirecast and the Streaming Server and has nothing to do with how your viewers
will receive the broadcast.

UDP is faster, but if you are using a Firewalls or are behind a NAT, you may not be able to use UDP and
in that case you should use TCP.

In other words, if Wirecast can send UDP to the server without errors, use it. It's faster.

Actions. 

When you have "Announce to QuickTime Streaming Server" selected, the gear icon will have these three
actions:

• Open in QuickTime Player

The stream is opened in QuickTime Player.

This is a handy shortcut for you and saves you from typing "rtsp://..." into QuickTime Player.

• Save Movie

A QuickTime movie is saved to disk which contains a reference to the configured stream.

This Movie file is very small and only tells QuickTime where to find your actual stream. It does not
contain the data of your movie. When you are not streaming, this movie will not work for your users.

You can send this movie to your users or post on your website so that your users can view your stream
when you are broadcasting.

• Save Multi-stream Reference Movie

A QuickTime movie is saved to disk which contains a reference to all of your QuickTime Streaming
Server streams.

You can send this movie to your users or post on your website so that your users can view your streams.
QuickTime will then choose which stream to use based upon the users settings. This is a very handy
way to broadcast multiple bit-rates at the same time.



Broadcasting

Wirecast 49 Telestream, Inc.

QT - Built-in Server

Wirecast ships bundled with the freely available Darwin Streaming Server from Apple.

Be aware that when you use the built in Streaming Server it is running on your local machine and will use
your local machines resources, thus slowing down Wirecast.

In addition each of your users will connect directly to your machine. If you don't have a lot of bandwidth
(say you are on a DSL and your viewers are on the internet), you will not be able to host many viewers.
One or two over DSL. Perhaps up to five or ten on a local network.

If you plan to have many viewers, you will want to use a hosted QuickTime Streaming Server.

File Location. 

The Streaming Server uses a file on the server to contain the specific settings for the stream. You need to
define the name of that file here. When you send your viewers the URL to use, this file name will be a part
of that URL. for example, if the File Location is "my_stream" and the Host Name is "www.stream.com"
then your viewers will need to use this URL: "rtsp://www.stream.com/my_stream.sdp". This information
is shown in the bottom of the window as you configure the settings.

Actions. 

When you have "Built-in Streaming Server" selected, the gear icon will have these three actions:

• Open in QuickTime Player

The stream is opened in QuickTime Player.

This is a handy shortcut for you and saves you from typing "rtsp://..." into QuickTime Player.

• Save Movie

A QuickTime movie is saved to disk which contains a reference to the configured stream.

This Movie file is very small and only tells QuickTime where to find your actual stream. It does not
contain the data of your movie. When you are not streaming, this movie will not work for your users.
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You can send this movie to your users or post on your website so that your users can view your stream
when you are broadcasting.

• Save Multi-stream Reference Movie

A QuickTime movie is saved to disk which contains a reference to all of your QuickTime Streaming
Server streams.

You can send this movie to your users or post on your website so that your users can view your streams.
QuickTime will then choose which stream to use based upon the users settings. This is a very handy
way to broadcast multiple bit-rates at the same time.

QT - Unicast

Wirecast lets you broadcast to a specific machine. This is called "Unicast".

Unicast Steps. 

You must perform these steps to broadcast to a specific machine:

• Configure The Broadcast Settings
See for details on this.

• Save the SDP file
After you are done configuring the screen, you need to save an SDP file.

This file is used by QuickTime client to know how the Broadcast is configured. Any time you change
anything on this page, you need to re-create the SDP file (this includes changing the Encoder Preset).

To save the SDP file, select "Save SDP File" from the Action menu (Gear icon) on this page.

• Give the SDP file to the viewer.
You need to send the SDP file to the viewer and have them open it on their machine with QuickTime
Player.

• Save the settings
Press the "Save" button to save your changes.

• Start your broadcast
Select the "Start Broadcast" menu from the "Broadcast" Menu. Or, on Macintosh, you can Press the
"Broadcast" button in the Toolbar area.

Configuring Broadcast Settings for Unicast. 

To do so, you need to select "Unicast" from the Destination popup as seen below:
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Address. 

The domain name or IP address of the machine that you will unicast to.

Video Port. 

The Video port that you will broadcast to on the machine.

Audio Port. 

The Audio port that you will broadcast to on the machine.

Actions. 

When you have "Unicast" selected, the gear icon might have these actions:

• Save SDP File

You must create an SDP file every time you change any option on this page (including the encoder
preset).

The SDP file must be given to the user on the machine that will listen to your broadcast.

Your remote viewer should open the SDP file using QuickTime player.

• Save Multi-stream Reference Movie [optionally present]

If you have other settings which use "Announce To QuickTime Streaming Server" then this menu option
is available.

Note
Your Unicast or multicast information is not stored in this file. Only QuickTime Streaming
Server streams are saved to this file.

QT - Multicast

Wirecast lets you broadcast to your local network so that any machine on that network can view the
broadcast. This is called "Multicast".
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Multicast Steps. 

You must perform these steps to broadcast to a specific machine:

• Configure The Broadcast Settings
See for details on this.

• Save the SDP file
After you are done configuring this setting, you need to save an SDP file.

This file is used by QuickTime client to know how the broadcast is configured.

Any time you change anything in this window, you need to re-create the SDP file (this includes changing
the Encoder Preset).

To save the SDP file, select "Save SDP File" from the Action menu (Gear icon) on this page.

• Give the SDP file to the viewer.
You need to send the SDP file to the viewer and have them open it on their machine with QuickTime
Player.

• Save the settings
Press the "Save" button to save your changes.

• Start your broadcast
Select the "Start Broadcast" menu from the "Broadcast" Menu. Or, on Macintosh, you can Press the
"Broadcast" button in the Toolbar area.

How Multicast Works. 

Your broadcasting computer simply starts sending data across your local network, defining that the data
is "multicast" meaning that it has no destination machine.

Since many applications could be doing the same thing, the broadcasting computer must have a unique
way of defining the data that is being multicast. This way, clients can choose between the multicast streams
available.

The multicast protocol uses a unique address (one for video, one for audio in our case). Although this
unique address looks like a TCP/IP address, it is not. It is simply a way to define uniqueness amongst all
"multicast" data flowing through your network.

Now that your broadcasting computer is streaming this data through your local network, any computer on
your local network can listen in.

The SDP file becomes the glue between your broadcast machine and your client machines. The SDP file
contains information such as what the multicast addresses are, what the encoding format is, etc.

You cannot multicast over the internet. It is only for your local network only.

Configuring Broadcast Settings for Multicast. 

To configure for Multicast you need to select Multicast from the Destination popup as seen below:
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Video Address. 

The unique address the multicast broadcast will use for video.

Although this looks like an internet address, it is not. This address can be anything, but must be unique
amongst applications on your network that use the "multicast" protocol. See "How Multicast Works" for
more information.

This field is filled with random numbers when first configured.

Video Port. 

The port that the multicast protocol uses for video. Normally, this is 5434.

Audio Address. 

The unique address the multicast broadcast will use for video.

Although this looks like an internet address, it is not. This address can be anything, but must be unique
amongst applications on your network that use the "multicast" protocol. See "How Multicast Works" for
more information.

This field is filled with random numbers when first configured.

Audio Port. 

The port that the multicast protocol uses for audio. Normally, this is 5432.

Actions. 

When you have "Multicast" selected, the gear icon might have these actions:

• Save SDP File

You must create an SDP file every time you change any option on this page (including the encoder
preset).
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The SDP file must be given to the user on the machine that will listen to your broadcast.

Your remote viewer should open the SDP file using QuickTime player.

• Save Multi-stream Reference Movie [optionally present]

If you have other settings which use "Announce To QuickTime Streaming Server" then this menu option
is available.

Note
Your Unicast information is not stored in this file. Only QuickTime Streaming Server streams
are saved to this file.

Record to disk

You can record your broadcast to disk at any time. You do not even need to be broadcasting to record
to disk.

This means that you can use Wirecast as a way to create movies you'll post on your website.

In addition, you can turn on and off Record To Disk independent of your broadcast.

Configuring for Record to Disk. 

You must first configure Wirecast to record to disk. To do so, open up the "Broadcast Settings" window,
which you'll find in the "Broadcast" menu (or Ctrl+Y).

Then select "Record To Disk" from the Destination popup. The window should look like this:

File. 

This is the file that Wirecast will use to save your broadcast to disk.

If you are using Auto Increment, then your files will have numbers appended to the end of them.

Browse. 
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You can select a file by using the Browse feature.

Auto Increment Filenames. 

When this feature is on, Wirecast will automatically put numbers on the end of your filename.

This enables you to start and stop your broadcast several times; Wirecast will generate a different movie
file for each "segment" you create.

Flash Media Server

Streaming to a Flash Media Server. 

Wirecast can stream to an RTMP/H.264 compatible streaming server (Flash Media Server, Wowza Media
Server, etc).

Wirecast only supports H.264 streaming over RTMP.
Flash Players earlier than Flash 9 Update 3 (Dec 2007) may not be able to view the H.264 based streams.

Note
Wirecast does not support alternative RTMP protocols (RTMPS, etc). Wirecast does not support
Vp6 or other Flash streaming codecs.

Address. 

Enter the address to the RTMP server you will stream to.

This is the same as the "FMS URL" in Flash Media Server.

Stream. 

Enter the name of the stream to broadcast as.

This is the same as the "Stream" in Flash Media Server.

Open Flash Media Encoder Configuration File. 
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Wirecast can import a Flash Media Encoder Config file (XML File).

Simply select the configuration file (either version 2.5 or version 3.0) and Wirecast will read the Address
and Stream from that file.

Many online streaming services offer a FME Config Files, and Wirecast should be able to also use these
files.

Note
No other information is used from the XML configuration file except for the Address and Stream.
No Encoding information is imported.

Flash to Ustream

Streaming to Ustream. 

To Stream to Ustream, enter your channel and username and press the "Genreate RTMP" button

Wirecast will configure the RTMP Stream and address for you, allowing you to easily stream to Ustream
from Wirecast.

Channel. 

This is either the URL to your channel (http://www.ustream.tv/channel/MyChannel), or the channel name
itself (MyChannel).

Username. 

Your Ustream username.

As of the writing of this documentation, Ustream did not yet support OpenIDs via this API.
The work around is to download the FME Configuration File from Ustream and use the the section called
“Flash Media Server” interface.

Generate RTMP. 
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After you have entered your channel and username, press "Generate RTMP" to generate the RTMP URL.

You only need to do this one time, as Wirecast will store the channel information for future streams.

Sign Up. 

You can sign up with Ustream by pressing the Ustream icon or by pressing "Sign Up"

Flash to Mogulus

Streaming to Mogulus. 

To Stream to Mogulus, enter your channel, username, and password. Then save the dialog and you are
ready to stream.

Channel. 

This is the name of your channel. This is the last part of the URL that is your channel.

For example, if your channel is http://www.mogulus.com//MyChannel then your channel name is My-
Channel

Auto Live. 

If Auto Live is ticked, Wirecast will request Mogulus to start your stream automatically.

Username. 

Your Mogulus username.

Password. 

Your Mogulus password.

Sign Up. 

You can sign up with Mogulus by pressing the Mogulus icon or by pressing "Sign Up"
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Flash Save To Disk

Saving Flash files to disk. 

Wirecast offers the ability to save your output to disk as either a Flash or MPEG-4 file.

Destination. 

To send to the QuickTime / Darwin Streaming Server, you must have "Announce to QuickTime Streaming
server" selected in the Destination popup.

File. 

Type the path to your file or use the Browse... button to locate the file.

Browse... 

Press the Browse... button to locate the file on disk via the operating system File dialog.

Auto increment Filenames. 

If you check this checkbox, then everytime you start recording to disk using this setting, a new file is
created.

If you do not check this checkbox, then your previous file will be overwritten.

Type. 

You can choose either Flash (.F4V) or MPEG-4 (.M4V) file types.
Only H.264 is supported when recording to disk.

Annotation settings

Media players often offer a feature which allows the viewer to see details about the broadcast they are
viewing.

For example, these can be seen in QuickTime Player under "Get Movie Properties" menu item in the
"Movie" menu. Select "Movie" than "Annotations" to see the details.
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In Windows Media Player 10, the Title is used as the name of the broadcast in the Now Playing List. You
can see the other properties by right clicking on the entry in the Now Playing List and selecting "properties"
then pressing the "Content" tab.

These Annotations can be configured for your broadcast in Wirecast.

When you configure annotations, they apply for all streams at the same time. This means changing your
annotations is very easy when you have multiple streams.

To configure the annotations, open up the "Broadcast Settings" window, which you'll find in the "Broad-
cast" menu (or Ctrl+Y).
Select "Annotations" from the tab.

Configuring Annotations. 

This is what the annotations window looks like:

Title. 

This is the title of the broadcast.

Author. 

This is the author of the broadcast.

Copyright. 

This is any copyrights that are on the broadcast.

Info. 

This is any additional info you'd like to associate with the broadcast.
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Chapter 9. Editing Encoder Presets
Overview

Wirecast Supports a wide variety of encoders (also known as "codecs").

An Encoder is what compresses the output of Wirecast for Broadcast. Without an encoder, the uncom-
pressed data that you would output would be too great to attempt to broadcast across the network. This
is why encoders are so important.

Modifying Encoder parameters is for advanced users. 

The settings that an encoder uses can be very complex, and there are a myriad of encoders available.

The choices that you have for choosing and configuring an encoder are therefore vast. It is for these reason
that Wirecast offers the most common settings for the encoders.

However, if you wish to go beyond the default presets, Wirecast offers you the ability to do so.

The Encoder Presets Window. 

The "Encoder Presets" window can be opened from the "Window" menu in Wirecast, and looks like this:

Changing the preset you are modifying. 

At the top of the window the "Encoder Preset" popup shows which encoder preset you are currently editing.
Simply use the popup to select the preset you wish to edit.

Modifying Wirecast default presets. 

We suggest that you leave the existing presets as they are so that you can always refer back to the standard
presets.
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Creating New Presets. 

To create a new preset, you must make a copy of an existing preset. You can do this by selecting "Save
Preset..." from the "Encoder Preset" popup.

Audio and Video Configuration Details. 

You can find details of configuring the common settings for the section called “QuickTime Video” and
the section called “QuickTime Audio”.

Windows Media Encoders

To modify a preset, you need to open the "Encoder Presets" window which can be found under the "Win-
dow" menu in Wirecast.
Be sure to select "Windows Media" from the "Output Format".

See the the section called “Overview” for general information on the topic of encoder presets.

Changing the preset you are modifying. 

At the top of the window the "Encoder Preset" popup shows which encoder preset you are currently editing.
Simply use the popup to select the preset you wish to edit.

Video Enabled. 

Wirecast offers the ability to optionally encode video for your broadcast. If you do not want your broad-
cast to include any video, simply uncheck "Video Enabled". This is the preferred method of producing
audio-only broadcasts, as you are ensured that no video data is put into the stream (even "blank" video
data can use bandwidth).

Encoder. 
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This is the Encoder (sometimes called "Codec" or "Compressor") you wish to use.

Options. 

This is the Encoder specific options. Many encoders have options that are specific to the encoder that you
can modify. It is beyond the scope of this documentation to describe all of the possible encoder options.

Depth. 

Some Encoders allow you to modify the Depth (or "Color Depth" or "Bits per Pixel") of the broadcast.
Picking a higher color depth will result in larger output, but lesser quality color. It is beyond the scope of
this document to describe all of the options an encoder may offer you here.

Width. 

This is the width of your resulting broadcast.

Lock to 16:9. 

This checkbox will lock your output size to 16:9; as you change the width, the height will be automatically
generated.

Height. 

This is the height of your resulting broadcast.

Quality. 

Many encoders allow you to adjust the Quality. Generally, encoders make a trade-off between Quality and
Speed (how much CPU is used during encoding). Sometimes lower quality will also affect the bandwidth
used.

Note
Some encoders may ignore this setting altogether.

Frames Per Second. 

This is the desired frame per second (FPS) of your broadcast. Note that the encoders try to stay "near" this
value, and you are not guaranteed to always get the exact value you enter here.

Keyframe. 

If you imagine a movie as a set of images one after another, then each image is called a frame.

To compress your video data, most compressors take a frame and make it a "reference" or "key".

This key frame (Keyframe) is sent as part of the broadcast, and all of the data after that keyframe is relative
to that Keyframe.

The benefit of this is that the compressor only needs to send what has changed since the last Keyframe.

The main drawback of this is that over time it's harder and harder for the compressor to make good "dif-
ference" information, especially if you have a lot of motion in the video. Another drawback is if your
viewer happens to miss a Keyframe, the data that their player will show will not be comprehensible until
the next Keyframe comes along.

You can control how often the encoder makes a new keyframe. Some encoders use this more as a "hint"
as to when to send Keyframes.
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Change this parameter to output more or fewer keyframes for your broadcast.

The more keyframes your broadcast has, the more bandwidth it will take (as less compression can occur).
However, more keyframes means motion in your video stream is better supported.

Limit data rate to. 

You can request that the encoder limits the output to a specific rate.

Note
Some encoders use this as a "hint", not as an absolute value.

QuickTime Video

To modify a preset, you need to open the "Encoder Presets" window which can be found under the "Win-
dow" menu in Wirecast.
Be sure to select "QuickTime" from the "Output Format".

See the the section called “Overview” for general information on the topic of encoder presets.

Changing the preset you are modifying. 

At the top of the window the "Encoder Preset" popup shows which encoder preset you are currently editing.
Simply use the popup to select the preset you wish to edit.

Video Enabled. 

Wirecast offers the ability to optionally encode video for your broadcast. If you do not want your broad-
cast to include any video, simply uncheck "Video Enabled". This is the preferred method of producing
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audio-only broadcasts, as you are ensured that no video data is put into the stream (even "blank" video
data can use bandwidth).

Encoder. 

This is the Encoder (sometimes called "Codec" or "Compressor") you wish to use.

Options. 

This is the Encoder specific options. Many encoders have options that are specific to the encoder that you
can modify. It is beyond the scope of this documentation to describe all of the possible encoder options.

Depth. 

Some Encoders allow you to modify the Depth (or "Color Depth" or "Bits per Pixel") of the broadcast.
Picking a higher color depth will result in larger output, but lesser quality color. It is beyond the scope of
this document to describe all of the options an encoder may offer you here.

Width. 

This is the width of your resulting broadcast.

Height. 

This is the height of your resulting broadcast.

Quality. 

Many encoders allow you to adjust the Quality. Generally, encoders make a trade-off between Quality and
Speed (how much CPU is used during encoding). Sometimes lower quality will also affect the bandwidth
used.

Note
Some encoders may ignore this setting altogether.

Frames Per Second. 

This is the desired frame per second (FPS) of your broadcast. Note that the encoders try to stay "near" this
value, and you are not guaranteed to always get the exact value you enter here.

Keyframe. 

If you imagine a movie as a set of images one after another, then each image is called a frame.

To compress your video data, most compressors take a frame and make it a "reference" or "key".

This key frame (Keyframe) is sent as part of the broadcast, and all of the data after that keyframe is relative
to that Keyframe.

The benefit of this is that the compressor only needs to send what has changed since the last Keyframe.

The main drawback of this is that over time it's harder and harder for the compressor to make good "dif-
ference" information, especially if you have a lot of motion in the video. Another drawback is if your
viewer happens to miss a Keyframe, the data that their player will show will not be comprehensible until
the next Keyframe comes along.

You can control how often the encoder makes a new keyframe. Some encoders use this more as a "hint"
as to when to send Keyframes.
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Change this parameter to output more or fewer keyframes for your broadcast.

The more keyframes your broadcast has, the more bandwidth it will take (as less compression can occur).
However, more keyframes means motion in your video stream is better supported.

Limit data rate to. 

You can request that the encoder limits the output to a specific rate.

Note
Some encoders use this as a "hint", not as an absolute value.

QuickTime Audio

To modify a preset, you need to open the "Encoder Presets" window which can be found under the "Win-
dow" menu in Wirecast.
Be sure to select "QuickTime" from the "Output Format".

See the the section called “Overview” for general information on the topic of encoder presets.

Changing the preset you are modifying. 

At the top of the window the "Encoder Preset" popup shows which encoder preset you are currently editing.
Simply use the popup to select the preset you wish to edit.

Audio Enabled. 

Wirecast offers the ability to optionally encode audio for your broadcast. If you do not want your broadcast
to include any audio, simply uncheck "Audio Enabled". This is the preferred method of producing video-
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only broadcasts, as you are ensured that no audio data is put into the stream (even "blank" audio may use
bandwidth).

Encoder. 

This is the Encoder (sometimes called "Codec" or "Compressor") you wish to use.

Options. 

This is the Encoder specific options. Many encoders have options that are specific to the encoder that you
can modify. It is beyond the scope of this documentation to describe all of the possible encoder options.

Rate. 

This is the rate of audio to use. The higher the value you choose, the better quality, but more bandwidth
is used.

Bits per Sample. 

This is how much data each "sample" of audio uses. The higher the value you choose the better quality
you will get, but more band width will be used.

Channels. 

You can choose to broadcast in mono or in stereo.

Mono uses less bandwidth than Stereo but Stereo is of course much nicer to listen to...
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Chapter 10. Desktop Presenter
Overview

Desktop Presenter. 

The Desktop Presenter is a small utility application that is available free with Wireacst.

You install Wirecast Presenter on a PC on your local network. The PC can be Mac or Windows and the
network can be either Ethernet or Wireless.

Wirecast can broadcast the desktop of the PC running Desktop Presenter, as shown below:

Zero configuration with Bonjour. 

If you are using Bonjour, Wirecast will automatically detect Desktop Presenter when it is launched on a
local PC. A new icon will appear in Desktop Presenter.

If either machine (the presenter PC or the Wirecast PC) does not have Bonjour installed, then you will
need to manually enter the TCP/IP address of the computer running Presenter by using the the section
called “Media” dialog in the Media menu.

A download for Bounjour for Windows is available here: http://www.apple.com/macosx/features/bonjour/

Desktop Presenter parameters. 

Desktop Presenter parameters can be found in the the section called “Performance” panel of the Preferences
dialog.

Some Scenarios to use Desktop Presenter. 

http://www.apple.com/macosx/features/bonjour/
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• Lecture Hall
If lecturers choose to install Desktop Presenter on their laptops, then you can broadcast their Keynote/
PowerPoint presentation directly from their laptop

If the lecturer is demonstrating a principle using their laptop (perhaps showing a 3D model of a molecule
and rotating it in 3D), Wirecast can also display this output to the remote users.

• Board Room
If speakers choose to install Desktop Presenter on their laptops, then you can broadcast their Keynote/
PowerPoint presentation directly from their laptop.

In addition, other programs such as Excel work perfectly with Desktop Presenter allowing the speaker
to spontaneously refer to data without having to create new slides.

• Training
As part of a training broadcast, you can switch to a live application to show exactly how one would
perform an action.

This saves the laborious step of having to create screen shots of every minute detail.

• Demonstration
You can demonstrate your business process, software, or hardware, live, as part of a presentation.

In the middle of your powerpoint, just switch applications and show the power of your business propo-
sition, directly using the applications required.

Download Desktop Presenter. 

Desktop Presenter can be downloaded from Telestream here: http://www.telestream.net/update-check/
wirecast/wirecast-update-main.htm

http://www.telestream.net/update-check/wirecast/wirecast-update-main.htm
http://www.telestream.net/update-check/wirecast/wirecast-update-main.htm
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Chapter 11. Media Management
Asset Manager

Asset Manager Dialog. 

Available on the the section called “Media” menu, the Reassign Media dialog allows you to change the
source of media in your document:

How to Reassign media. 

1. Click on the media you wish to assign ot another source.

2. Either select the media from the popup, or press the Browse button and locate the replacement media
on disk.

3. Press Apply Button

Reassignment is not done until you press the Apply button.

Desktop Presenter IP Address. 

When you select a Desktop Presenter source from the Media list, you will also be able to change the IP
address to the Desktop Presenter.

This means you can build a Wirecast presentation with place-holders and when your presenter shows up
on site, you can just reconfigure the document to point at the correct Desktop Presenter.

Wirecast Documents

How media is stored in a Wirecast document. 

Wirecast stores a path to your media in the Wirecast document.

This means if you move media around, Wirecast will no longer be able to find the original media.

If media has been moved, you may use the the section called “Asset Manager” dialog to specifically point
to the new media location.



Media Management

Wirecast 70 Telestream, Inc.

Keep your document and media together. 

Wirecast does keep track of the "relative" path to your media.

This means if you you have a piece of media in the same directory as the document, and you move both
the document and media to a new position, Wirecast will still find the media.

In addition, if you store all of your media in a folder that is in the same directory as your document, then
Wirecast will be able to find the media if you move the document and the directory containing the media.
This is akin to the very common practice of using an "images" directory for HTML pages.

For example, here using this sample directory tree:

 MyWirecastDocs
  Presentation1
   presentation.wcst
   image1.jpg
   MediaDirectory
    movie1.mov
    image2.jpg
     

You could move the directory "Presentation1" to a new location and when you open presentation.wcst,
Wirecast will find the 3 pieces of media: image1.jpg, movie1.mov and image2.jpg.
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Chapter 12. Menus
Overview

This chapter documents the menus that are available in Wirecast:

• the section called “File”

• the section called “Edit”

• the section called “Switch”

• the section called “Media”

• the section called “Broadcast”

• the section called “Layout”

• the section called “Window”

• the section called “Help”

File

This section contains information on each item in the File menu of Wirecast:

New. 

Creates a new, empty Wirecast document.

Open... 

Presents the Open dialog for you to choose a Wirecast document from disk.

Open Recent. 

You can choose from up to 15 most recently accessed documents.

Every time you open or save a document, it is entered into the Open Recent list.

Import Media. 

Allows you to import media into Wirecast.

A new shot is created with the media.

Save. 

Saves the document. If you haven't already saved the document to a file, then a Save As dialog is presented.

Save As... 

Presents the Save As dialog so that you can save a document.

Close Window. 

Will close the foremost window.
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If the window is a document, all of the Shot Editor windows are closed as well.

If Wirecast is still broadcasting for the document, you will be asked if you wish to stop the broadcast.

If the document has not been saved, you'll be asked to save the document before closing it.

If the window is a document and the document's broadcast is playing, you'll be asked to stop the broadcast
before closing the document.

Preferences. 

Opens the the section called “Overview” window.

If the Preferences window is already open, it will simply be brought forward.

Exit. 

Wirecast will close all documents and then exit.

If the broadcast is playing, you'll be asked to stop the broadcast first.

If a document has not been saved, you will be asked to save the document first.

Edit

This section contains information on each item in the Edit menu of Wirecast:

Undo. 

Your last change is undone. Undo is only available in some windows (such as the shot editor).

Wirecast offers an unlimited (memory permitting) amount of undo actions. However, undo information
is stored on a per-window basis. If you close a shot editor and then reopen it, your undo information will
be lost.

Redo. 

Your last undo is itself undone. Redo is only available in some windows (such as the shot editor).

Wirecast offers an unlimited (memory permitting) amount of undo actions. However, undo information
is stored on a per-window basis. If you close a shot editor and then reopen it, your undo information will
be lost.

Edit Shot. 

Edits the shot. See the section called “Overview” for more information on editing shots.

You can also double-click on a shot to edit it.

You can also right-click on a shot and select "Edit Shot" to edit the shot.

The Inspector window is a shot editor window which always edits the last touched shot. Here is information
on the difference between the section called “Inspector vs. Editor”.

Rename Shot. 

Brings up a window to allow you to rename the shot.

You can also right-click on a shot and select "Rename Shot" to rename the shot.
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Duplicate Shot. 

Will duplicate the currently selected shot.

You can also right-click on a shot and select "Duplicate Shot" to duplicate the shot.

Add Shot. 

Creates a new, empty, shot.

You can also right-click on a shot and select "Add Shot" to add a new shot.

Delete Shot. 

Deletes the currently selected shot.

You can also right-click on a shot and select "Delete Shot" to delete the shot.

Move To Layer. 

Will move the shot to the given layer.

When shots are created, they are assigned to a specific layer. They exist on that layer until you move them
or delete them.

You can also right-click on a shot and select "Move To Layer" to move the shot to another layer.

See the section called “Layers” for more information on layers in Wirecast.

Switch

This section contains information on each item in the Switch menu of Wirecast:

Go. 

Will perform the Go action. This is the same as pressing the the section called “Transitions / Time / Go ”.

Transitions - three selected transitions. 

Each document has 3 transition buttons that you can configure to any transition that Wirecast supports.

These 3 menu items in the Switch menu allow you use key strokes to select these 3 transitions.

For information on how to modify which transitions appear in this menu, see the section called “Transi-
tions / Time / Go ”. The selections you make for the three buttons are the same three items you'll find
in this menu.

AutoLive. 

This menu item toggles (turns on and off) the the section called “AutoLive” feature.

The AutoLive feature can also be toggled by changing the checkbox labeled the section called “AutoLive”

Briefly, AutoLive is a fundamental feature of Wirecast which allows you to control whether clicking on a
shot in the main window automatically makes the shot you clicked on become live.

More information on AutoLive can be found in the the section called “AutoLive and usage” section of
this manual.
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Media

This section contains information on each item in the Media menu of Wirecast:

Start Playing All Movies. 

Any movies that are not playing will begin playing.

Pause All Movies. 

All movies that are currently playing are paused.

Play to Next Point. 

Some media have embedded markers ("points"). An example is a Keynote Movie that has been ???.

This menu option will play all media to the next marker / point.

Jump to Previous Point. 

Some media have embedded markers ("points"). An example is a Keynote Movie that has been ???.

This menu option will force all media to jump back to the previews marker / point, and then pause.

New Desktop Presenter. 

If Bonjour not installed on the computer that is running the section called “Overview”, then you may need
to manually enter the TCP/IP address of the computer running Presenter.

You may also use this menu option to pre-configure your document if you wish to add a Desktop Presenter
before it is available. You can change the IP address to a Desktop Presenter in the the section called “Asset
Manager” dialog.

Asset Manager. 

Opens the the section called “Asset Manager” dialog.

Configure Devices. 

Some devices (cameras, etc) may be able to be configured.

For example, you can configure an iSight to manually change the focus, contrast, brightness, etc. Other
devices have multiple inputs that you can choose between (AlchemyTV Card, etc).

Choose the device you wish to configure from this menu.

Note
The configuration user interface is provided by the device maker. It is beyond the scope of this
document to describe all of the features available for all devices. See the documentation provided
with your device on how to configure it.

Broadcast

This section contains information on each item in the Broadcast menu of Wirecast:

Broadcast Settings. 

Opens the the section called “Overview”.
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Start Broadcasting / Stop Broadcasting. 

Will start (or stop) broadcasting to the network.

If you have not configured the the section called “Overview” for this document, the window will be opened.

Start Recording / Stop Recording. 

Will start (or stop) recording to disk.

If you have not configured the the section called “Overview” for this document, the window will be opened.

Layout

This section contains information on each item in the Layout menu of Wirecast:

Preview. 

Shows or Hides the Preview area in the main window.

You can also click on the "Preview" icon in the Main Window Toolbar.

See the section called “Main Window Layout” for more information on this option.

Layer Visibility. 

Shows or Hides the Layer Visibility mini icons.

See the section called “Main Window Layout” for more information on this option.

Master Audio. 

Shows or Hides the Master Audio controls.

See the section called “Main Window Layout” for more information on this option.

Main Shot List. 

Shows or Hides the main shot list.

See the section called “Main Window Layout” for more information on this option.

Output Statistics. 

Shows or Hides the output statistics.

See the section called “Main Window Layout” for more information on this option.

Layer Panel. 

Shows or hides the layer panel.

See the section called “Main Window Layout” for more information on this option.

Go to layer. 

The bottom part of the the section called “Layers” and the the section called “Layer Windows” have a
currently selected layer.
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To see what the currently selected layer is, you can open the Layer Panel (see above). The currently selected
layer is highlighted.

To change layers, you can click on the name of the layer you want to go to.

Alternatively, the menu item "Go to layer" will switch layers in a keystroke.

Editor Preview. 

This item is only available when the the section called “Overview” is open.

This item will Hide or Show the Preview part of the Shot Editor window.

For more information, see the the section called “Edit Window Layout” in the the section called
“Overview” chapter.

Window

This section contains information on each item in the Window menu of Wirecast:

Inspector. 

Will open the Inspector window (there is only one for each document).

The Inspector is very similar to the shot editor, except it always edits the the last shot touched. The differ-
ence is the section called “Preview / Live”.

Encoder Presets. 

Opens the the section called “Overview” window.

New Layer Window. 

Opens a new the section called “Layer Windows”.

Show Device Manager. 

Opens the the section called “Device Manager” window.

Camera Preview. 

Shows a preview of all cameras currently connected to your computer.

Help

This section contains information on each item in the Help menu of Wirecast:

Help. 

Opens this documentation.

Open Tutorial HTML. 

Opens the Wirecast Tutorial in your browser.

To follow the tutorial, you'll need to Create a Document for the Tutorial as well.

Create Document for Tutorial. 
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Creates a new Wirecast Document which contains the media necessary for following the Tutorial.

Report a Bug. 

Your default web browser is used to open a link to our bug reporting form.

Please give us as much information as you can about your computer, what you were doing and any sup-
porting material regarding the problem. For example, if a specific piece of media is troublesome, please
set it aside so that we can have a look at the problem first-hand.

If in the unlikely event that Wirecast crashes, you can also send us a debug log by pressing the "Upload
Debug Log File" in the the section called “Advanced” preferences.

Provide Feedback. 

A link to the Telestream website where you can enter any feedback you may have about our product or
company.

Visit Telestream Website. 

A link to the Telestream website home page.

Visit Wirecast / Desktop Presenter download page. 

You default browser is opened to the download pages for Wirecast/Desktop Presenter.

Acknowledgments. 

Opens this documentation to the the section called “Overview” section.
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Chapter 13. Preferences
Overview

  Wirecast was designed to have as few application-wide preferences as possible, so that most of your
options are configurable into the document or shot.

Accessing Preferences. 

The preferences window can be opened by selecting "Preferences" in the "Wirecast" menu (or Ctrl+,).

Preference pages. 

Preferences are grouped in Pages in Wirecast.

Click one of the 3 icons in the top of the Preferences window to change the page of preferences you are
currently editing.

These are the pages available in the preferences window:

• the section called “General” -- general options

• the section called “Performance” -- application performance options

• the section called “Register” -- application registration

• the section called “Software Update” -- keep your software up-to-date

• the section called “Advanced” -- advanced options

Saving preferences. 

Wirecast saves your preferences every time you make a change, and all changes are immediately applied
throughout Wirecast.

General

General settings are a part of the the section called “Overview”. The preferences window can be opened
by selecting "Preferences" in the "Wirecast" menu (or Ctrl+,).
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Open last document on startup. 

When checked, the last document you used will be opened when Wirecast starts up.

default: on.

Show checkerboard background in Shot Editor. 

When checked, a checkerboard background is shown in the the section called “Overview”.

default: off.

Aspect Ratio. 

Wirecast allows you to device the aspect ratio of your broadcast canvas.

This is the relative width/height of the Preview and Live Broadcast area in Wirecast.

The aspect ratio should match the aspect ratio of the Encoder Preset you are going to stream with so that
no squeezing is done by Wirecast to match your encoder presets aspect ratio.

As of Wirecast 3.1 when you selection this option, Wirecast will automatically reset any media that has
"Respect Aspect Ratio" enabled.

Performance

Performance settings are a part of the the section called “Overview”. The preferences window can be
opened by selecting "Preferences" in the "Wirecast" menu (or Ctrl+,).
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Draw highest quality icons. 

Controls the quality of the icons as drawn in Wirecast.

This feature has no affect on what your viewers see with Wirecast; This only affects what you as a user
of Wirecast can see.

This affects performance of the application because it takes CPU to draw higher quality icons.

If your machine is having trouble broadcasting your stream, (the section called “Main Window Layout”),
try unchecking this checkbox.

default: on.

Video Display Rate. 

Defines how many frames per second Wirecast will generate frames.

If you want very smooth transitions, you can use 60, but this will also require a higher end machine.

default: 30

Desktop Presenter Frame Rate. 

Defines how many frames per second Wirecast will ask the Desktop Prsenter for frames.

If the Desktop Presenter does not have a lot of motion (say a Keynote presentation), you might try reducing
this number. If you slow down the FPS you may consider increasing the quality (see below).

When Automatic is selected, Wirecast attempts to keep a 30 fps rate. However, when Automatic is selected,
Wirecast may reduce the framerate as the actual output FPS changes. For example, if your true streaming
FPS is very low (say 5 FPS), then Wirecast may choose to reduce the framerate to Desktop Presenter.
If you use a specific FPS number, Wirecast will always attempt to keep your specific FPS, regardless of
the streaming FPS.

default: Automatic

Desktop Presenter Quality. 

Defines the quality of each frame Wirecast asks of the Desktop Presenter.

If the Desktop Presenter does not have a lot of motion (say a Keynote presentation), you might try to
increase this to Highest. You may also consider reducing the frame rate.

default: Automatic

Register

Register settings are a part of the the section called “Overview”. The preferences window can be opened
by selecting "Preferences" in the "Wirecast" menu (or Ctrl+,).
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Serial Number. 

This is the serial number that we have provided to you.

Note
The serial number never contains quotation marks. When we send you the serial number, we may
enclose it in quotation marks (e.g., "123-345-678"). Do not include the quotation marks.

HDV Serial. 

If you wish to use an HDV camera in HDV mode, you need to purchase an HDV Pack. When you pur-
chase an HDV Pack, you will recieve a second serial number which you enter here to enable HDV within
Wirecast.

Note
You can use most HDV cameras in DV mode without purchasing an HDV Pack.

Purchase Now. 

You can purchase online directly through the application either a Wirecast serial number or an HDV serial
number for Wirecast.

The Purchase Now button is only active when you have not registered either a Serial Number or HDV
Upgrade Serial number.

Enter Serial Number. 

If you have previously purchased a copy of Wirecast or the HDV Upgrade, you can enter the serial number
here.

If you have both, just enter one at a time.

The Enter Serial Number button is only active when you have not registered either a Serial Number or
HDV Upgrade Serial number.

Deactivate Serial Numbers. 

If you have activated either a Wirecast Serial number or an HDV Upgrade serial number, you can deacitvate
them here.
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You can always re-activate the serial number again if you would like to do so.

Deactivating a serial number allows you to re-activate it on another computer.

The Deactivate Serial Numbers button is only active when you registered a serial number.

Demonstration Mode. 

When no product serial number is entered, Wirecast will water-mark all output (both to disk and network).
Video is water-marked with a periodic overlay of the Wirecast logo. Audio is water-marked with a periodic
voice over.

When no HDV serial number is entered, Wirecast will water-mark all HDV media.

Software Update

Software Update settings are a part of the the section called “Overview”. The preferences window can be
opened by selecting "Preferences" in the "Wirecast" menu (or Ctrl+,).

Automatically check for updates. 

By default, Wirecast will check in with the Telestream website each time you launch Wirecast.

No personal information is transferred to Telestream during this action.

default: on.

Check Now. 

Will immediately check if Wirecast is up to date.

No personal information is transferred to Telestream during this action.

Advanced

Advanced settings are a part of the the section called “Overview”. The preferences window can be opened
by selecting "Preferences" in the "Wirecast" menu (or Ctrl+,).
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Capture Device Size. 

Controls the size of the video that is captured from your cameras or other live input devices.

Reduced is advised for performance reasons, unless you will use the the section called “Overview” features
of Wirecast.

default: Reduced

Device Deinterlacing. 

Some devices (specifically DV Cameras) will provide data that is interlaced, which means that each half
of the frame is captured at a different time.

Due to the fact it is captured at a different time, when there is a lot of motion in the video, you can see
horizontal lines in the output.

By selecting "Blend" from this popup, the interlacing artifacts are removed using a blend algorithm.

If you use "Reduced" in the "Capture Device Size" you do not need to deinterlace.

default: None

High Quality Video. 

Controls the quality of the decode performed on your source media files.

Your media must be decoded before being broadcast, and this control tells Wirecast how to perform this
decode.

You should leave this option on unless you have seen specific performance issues.

default: on.

Use GPU Compression. 

On appropriate hardware, Wirecast can gain significant speed improvements by using your graphics card
to preprocess frames before sending them to the encoders.

You should leave this option on unless you experience issues with your encoded output.

This checkbox is included in the rare case you choose to use an Encoder that does not support the features
necessary.
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To date, Telestream is unaware of any encoders that will not work with this feature.

default: on.

Upload Debug Log File. 

Very rarely, we may require some very detailed debugging information to help us understand issues you
have reported.

This button will upload a text file to our server for our engineers to look at.

Please only use this feature under direction of our support staff.

CPU performance issues. 

While you are broadcasting, turn on the the section called “Main Window Layout” and watch the CPU.

If the CPU usage is nearing 95%, you may consider not using High Quality Video. Experiment with turning
off the High Quality Video.

Dropped Frames performance issues. 

While you are broadcasting, turn on the the section called “Main Window Layout” and watch the FPS
(Frames Per Second).

If this value is consistently dropping well below your target FPS, consider not using High Quality Video.
Experiment with turning off the High Quality Video.
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Chapter 14. Main Window
Overview

The main window (or Document window) as shown below, is made up of four main components:

• the section called “Preview / Live” -- the large area just below the Toolbar

• the section called “Transitions / Time / Go ” -- the are with "Cut", "Smooth", "Bowstring" and "Go"
buttons

• the section called “Shot Selection Area” -- the area which shows the shot icons

Preview / Live

When you open a new document in Wirecast, only the Live area is shown. The Live area shows what is
sent to your viewers (though what you see in the live area is before the encoder/compression).

When the section called “AutoLive” is off, you can make several changes without your viewers seeing the
change. This is most useful when you are the section called “Using an Engineer” to run your broadcast.

When you do several changes without your viewers seeing them, you most likely want to see what those
changes will look like to your viewers. This is what the Preview is for.

To see the preview, you can select "Preview" from the "Layout" menu in Wirecast.

Here, the main window shows both the preview (on left with green "P") and live (on right) displays:
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In the above example, AutoLive is off, "River" is the current Live shot (what the viewers would see if you
were broadcasting), and "Ripples" has been selected and is in Preview.

If you press the section called “Transitions / Time / Go ” button, the "Ripples" shot becomes Live, using
the "Smooth" transition.

Optional Views

The Main window has several small panels that you can open and view.

These are explained in detail in the the section called “Main Window Layout” section of Usage Patterns
chapter.

Transitions / Time / Go

The transition area is in the middle of the main window and looks like this:

Transition Buttons. 

There are three Transition buttons. In the image above, the transitions "Cut", "Smooth" and "Bowstring"
are configured for the three buttons.

In the screen shot above, the transition "Smooth" is the currently selected transition (the one that will be
used).

Changing the selected transition button. 

If you single-click on the "Bowstring" button, then it will become highlighted and "Bowstring" will be
the current Transition, as shown here:

As you can see, you have 3 transitions at the ready at all times.
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Note
You can also select one of the three buttons by using Command-1, Command-2, and Command-3,
respectively.

Changing the transition for a transition button. 

If you click and drag on one of the three transition buttons, you can select a different transition for the
button.

Here we've selected "Swoop" instead of "Cut":

Duration Button. 

The duration of the transition is controlled using this button:

This button controls the duration of the transition (except for the "Cut" transition which is immediate).

If you select "Slow" from the popup, you'll notice that the icon contains a small Turtle, as shown here:

Go Button. 

The Go button (or Ctrl+G) will take any changes you have made and make them Live using the selected
transition and duration.

However, the Go button only becomes important when you have turned the section called “AutoLive” off.
This is because when AutoLive is on, every time you click on a shot, the Go action automatically executed
for you. See the section called “AutoLive and usage” for more information on using AutoLive.

Shot Selection Area

The bottom part of the main window contains the shot selection area:

Changing Shots. 

You change shots by clicking on a shot. Above, we have selected "Ripples" the currently selected shot.

Shot Content Filter. 

The



Main Window

Wirecast 88 Telestream, Inc.

popup controls a filter which can be applied to the list of shots.

Selecting a filter will change which shots are shown in the shot list. For example, if you select "Images"
from the list, only those shots which have images in them will show.

This can be helpful in finding a shot if you have several.

Shot Name Filter. 

You can also filter the shot list by name. To do this, type into the Search area, as we have typed "Riv"
below. Notice how the selection has changed to show only the "River" shot:

Add Shot. 

You can add a new, empty shot by pressing the

button. The same action is available by right-clicking on a Shot and selecting "Add Shot".

Delete Shot. 

You can delete a shot by first selected it and then pressing the

button. The same action is available by selecting "Delete Shot" from the "Edit" menu (or Ctrl+BkS) Finally,
you can right-click on the Shot and select "Delete Shot".

Editing a shot. 

You can edit a shot by double-clicking on it. You can also edit a shot by selecting "Edit Shot" from the
"Edit" menu (or Ctrl+E). Finally, you can right-click on the Shot and select "Edit Shot".

Duplicating a shot. 

You can duplicate a shot by selecting "Duplicate Shot" from the "Edit" menu (or Ctrl+D). The same action
is available by right-clicking on the Shot and selecting "Duplicate Shot".

Renaming a shot. 

You can rename a shot by selecting "Rename Shot" from the "Edit" menu (or Ctrl+R). The same action is
available by right-clicking on the Shot and selecting "Rename Shot".

Moving a Shot to another Layer. 
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You can move a shot to another layer by selecting "Move to Layer" from the "Edit" menu. The same action
is available by right-clicking on the Shot and selecting "Move to Layer".

When shots are created, they are assigned to a specific layer. They exist on that layer until you move them
or delete them.

You can also right-click on a shot and select "Move To Layer" to move the shot to another layer.

See the section called “Layers” for more information on layers in Wirecast.

Growing / Shrinking the Shot Icons. 

In the lower right of the window, you'll find two icons, which look like this:

These two icons control the size of the icons in the Shot list. Clicking the left "mountain" will cause the
icons to become smaller. Clicking on the right "mountain" will make the icons become bigger.

Layers

Wirecast allows you to put shots on five different layers. When Wirecast first opens, the Layer panel is
not shown.

To show the layer panel, select "Layer Panel" from the "Layout" menu, or slide the panel out using the
knob. Here's what the panel looks like, when open, with the "Normal" layer selected.

What is a Layer. 

Layers imply an order to "drawing" in the broadcast. The Bottom layer ("Audio") is drawn first. Then the
"Background" layer is drawn, then the "Normal" layer, then the "Foreground" and finally the "Title".
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This means that the Title layer is always drawn on top of the other layers

Note
The audio layer will actually draw, if the shot selected there has visual media in it.

Using multiple layers is one way that you can get Wirecast to show, for example, a company Logo. You
could have a shot on the "Foreground" layer which is your the section called “Overview”. If selected, it
will always be visible, above your "normal" layer. The the section called “Getting Started” covers this
example in detail.

Changing Layers. 

To see other layers, simply click on the name of the layer you wish to switch to. Here, we have clicked
on the "Foreground" (only the bottom part of the window is shown). Notice that the Shot list has changed
to show the shots that are in that layer.

Note
There are key equivalents available to help you quickly change layers. See the "Go to layer" menu
item in the "Layout" menu.

Moving a shot between Layers. 

A shot can be moved between layers by selected "Move to Layer" from the edit window (or right-clicking
on the shot and selecting from the popup-menu).

When shots are created, they are assigned to a specific layer. They exist on that layer until you move them
or delete them.

You can also right-click on a shot and select "Move To Layer" to move the shot to another layer.

See the section called “Layers” for more information on layers in Wirecast.

Layer Windows. 

If you want to see more than one layer at a time, be sure to read about the section called “Layer Windows”.

AutoLive

Where is the AutoLive feature. 

The AutoLive feature can be found on the bottom, middle of the the section called “Overview”.

The AutoLive feature can also be found in the the section called “Switch” menu.

What is AutoLive. 

AutoLive controls whether changes made in the main window automatically go live or not.
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When AutoLive is on... 

If you click on a shot, the shot is automatically taken Live for you in the broadcast (using the current
transition and transition duration).

When AutoLive is off... 

If you click on a shot, the shot is not taken live. To actually take the shot live, you must press the the
section called “Transitions / Time / Go ”.

More information. 

AutoLive is discussed in more detail in the section called “AutoLive and usage”.
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Chapter 15. Shot Editing
Overview

All of the information that Wirecast uses to display a shot is accessed through the shot editor window (or
Inspector window).

How to edit a Shot. 

There are several ways of opening the shot editor:

• Double click on a shot in the main window

• Select "Edit Shot" from the "Edit" menu

• Right-click on a shot and select "Edit Shot"

To open the shot Inspector, you can:

• Select "Inspector" from the "Window" menu

• Click on the "Inspector" button in the Main window Toolbar

Once the shot inspector is open, selecting (single-clicking) on the shot in the main window will allow
you to edit it.

When are my changes made active? 

Wirecast always makes your changes available in the the section called “Preview / Live”.

However, your changes only become Live when you specifically tell Wirecast to the section called “Tran-
sitions / Time / Go ”.

Note
The exception to this occurs in the the section called “Overview” where you can specifically
make your changes the section called “Live Playback”.

You can make your changes live by pressing the the section called “Transitions / Time / Go ” or by using
Command-G. Command-G is very useful when you are editing a shot and want to make your changes
immediately live.

The the section called “AutoLive and usage” feature does not apply to the shot editor.

How to find information about the Shot Editor. 

These pages describes the bigger picture of shot editing:

• the section called “Inspector vs. Editor” -- a description of the difference

• the section called “Window Layout” -- a description of the different parts of the window

• the section called “Optional Views” -- the optional parts of the edit window
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• the section called “Live LED” -- a description of the "live" LED

• the section called “Shot Elements” -- the elements that exist within a shot

If you're looking to find documentation from the perspective of a the section called “Shot Elements”:

• the section called “Title”

• the section called “Foreground”

• the section called “Scene”

• the section called “Background”

• the section called “Audio”

• the section called “Channel A/B/C”

The rest of the chapters of the book address specific panels of the edit window. Each the section called
“Shot Elements” uses one or more of these panels:

• the section called “Overview” -- the scene to use

• the section called “See Titling Capabilities” -- title configuration

• the section called “Overview” -- media selection

• the section called “Overview” -- where on the screen parts of a shot exist

• the section called “Overview” -- audio, movie in point, output, etc

• the section called “Overview” -- how the parts of a shot move as they build in and build out

Inspector vs. Editor

A shot can be edited in two ways.

You can double-click on the shot and open an editor specifically for that shot, or you can open the inspector
window and then click on the shot you wish to edit.

Both windows have the exact same controls in them. the only difference is whether you have a window
for a specific shot (Editor) or you have a window which shots share (Inspector).

A shot can be in both an Editor and in an Inspector without causing problems to Wirecast.

How to open the Inspector. 

You can open the inspector window by selecting "Inspector" from the "Window" menu You can also press
the "Inspector" button on the window Toolbar.

What if no shot is selected. 

If no shot is currently selected, the inspector's buttons and other GUI elements are not functional.

There is only one Inspector. 
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Wirecast only opens one Inspector window.

Window Layout

The main window can be broken up into 3 major sections:

• Preview Area -- Top part of the window

This area of the window shows a preview of what the shot looks like.

• Shot Elements -- Bottom Left of the window

This area is where you select the elements to edit within the shot.

You can also modify whether the the section called “Shot Elements” is visible here.

• Edit Panels -- Bottom Right of the window

This Tab area holds all of the configuration panels.

The tabs that are available in this area changed depending on the type of element that is currently se-
lected.

In the above example, the Main element is selected, and the only panel available is the the section called
“Overview” panel.

How to find information on the panels. 

The rest of the chapters related to editing are centered around the various panels.
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Optional Views

You can modify the look of the edit window. See the section called “Edit Window Layout” for details
on how to do this.

Live LED

In the very middle of the edit window, you'll see a small "LED" on the far right (it is red in the example
above).

The intent of this small light is to tell you whether you are editing a shot which is LIVE or not.

The color can be one of:

• Red -- the shot you are editing is currently Live in the broadcast

• Yellow -- the shot you are editing is currently in Preview (if you press "Go" it will be Live)

• Clear -- the shot you are editing is neither in Live nor in Preview

Shot Elements

What are Shot Elements? 

Simply put, an element is just a part of a shot -- a title, or a graphic.

Layering. 

However, there is a forced, predefined layering of elements in a shot. The Title Element is on top of the
Foreground element, etc.

Channels. 

There are three elements that appear the bottom of the the section called “Shot Elements” list -- Channel
A, Channel B, and Channel C.

These elements are for fine-control of the the section called “Channels” in a scene.

To be able to edit a the section called “Channels”, you must select a Scene which has the channel in it. See
the section called “Overview” for more information on selecting scenes and the channels within them.

Selecting a Shot Element. 

You select a the section called “Shot Elements” by clicking on the name of the element. For example, if
you click on the word "Foreground" the Foreground element is selected. Here is what the Shot element
selection area looks like (with the Foreground element selected):
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Shot Element Visibility. 

The checkbox to the left of each the section called “Shot Elements” controls the visibility of that shot
element in the shot.

For example, if your shot has a title in it, you can turn off the Title in the shot by simply turning off the
checkbox. All of your title data still stays within the shot -- it's just not shown.

This can be a powerful way to use Wirecast -- preload your shots with Titles and turn them on and off
during run time.

Note
The first time you select a shot element, its visibility will be turned on for you (it is assumed if
you are clicking on it, you want to see it).

Shot Element Documentation. 

Each type of element in a shot is configured a little differently.

For this reason, when you select a the section called “Shot Elements”, the configuration tabs available
will change.

Here is the documentation for each shot element:

• the section called “Title”

• the section called “Foreground”

• the section called “Scene”

• the section called “Background”

• the section called “Audio”

• the section called “Channel A/B/C”
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Chapter 16. Shot Element Panels
Overview

This chapter allows you to look up the documentation for a particular the section called “Shot Elements”.

When you are the section called “Overview” you must choose which shot elements to edit.

You choose these shot elements by clicking on the name of the shot element in Shot Editor. Here is an
example of "Foreground" being selected in the shot element selector:

Here are the shot elements that the the section called “Overview” allows you to configure:

• the section called “Title”

• the section called “Foreground”

• the section called “Scene”

• the section called “Background”

• the section called “Audio”

• the section called “Channel A/B/C”

Title

To change title information in a shot, you must first the section called “Overview” then select a Title from
the the section called “Shot Elements” list.

Title. 

Each shot can have a title as a part of the shot.

A shot can also have only a title. This is described more in the section called “Where to put Titles”

More information is available here on the section called “Overview”.

A title consists of a template (with graphics, etc) and your specific text (say, interviewee's name) or title
of a piece of music being reviewed.
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Available Panels. 

The Title the section called “Shot Elements”, offers the following panels for editing:

• the section called “Modifying Titles” -- The text, font, etc, of a title

• the section called “Overview” -- Position, crop, etc, of the the section called “Shot Elements” in the shot

• the section called “Overview” -- The Build-In and Build-Out motion of the the section called “Shot
Elements”

Foreground

To change foreground information in a shot, you must first the section called “Overview” then select a
Foreground from the the section called “Shot Elements” list.

Foreground. 

Each shot can have a foreground piece of media as a part of the shot.

For example, you may choose to put a Logo as part of the shot. Here is some more information on the
section called “Overview”.

A Foreground the section called “Shot Elements” is a piece of media (movie, still picture, etc) that you
can position and is behind the title, but in front of all other shot elements in the shot.

Available Panels. 

The Foreground the section called “Shot Elements”, offers the following panels for editing:

• the section called “Overview” -- The media for the the section called “Shot Elements”

• the section called “Overview” -- Position, crop, etc, of the the section called “Shot Elements” in the shot

• the section called “Overview” -- The playback and audio controls for the the section called “Shot El-
ements”

• the section called “Overview” -- The Build-In and Build-Out motion of the the section called “Shot
Elements”

• ??? -- On Tiger only, the filters to apply to this the section called “Shot Elements”

Scene

To change scene information in a shot, you must first the section called “Overview” then select a Scene
from the the section called “Shot Elements” list.

Scene. 

Each shot can have a single scene, which can contain multiple pieces of media (depending on the scene
you choose).

The Scene panel is the only panel available from the Scene the section called “Shot Elements”.

However, the media that you assign to the channels of a scene are edited by selecting the channel shot
element. For example, if you assign a piece of media to Channel A, then you can edit specific settings for
that media by clicking on the "Channel A" the section called “Shot Elements”.
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Available Panels. 

The Scene the section called “Shot Elements”, offers only the scene panel for editing:

• the section called “Overview” -- The main scene of the shot

Background

To change background information in a shot, you must first the section called “Overview” then select a
Background from the the section called “Shot Elements” list.

Background. 

Each shot can have a background piece of media as a part of the shot.

For example, you may choose to put a simple pattern as the background.

A background is especially useful when you choose a the section called “Scene” which does not com-
pletely fill the screen. A background allows you to define what appears behind the scene. By default, the
background is simply black.

Available Panels. 

The Background the section called “Shot Elements”, offers the following panels for editing:

• the section called “Overview” -- The media for the shot element

• the section called “Overview” -- Position, crop, etc, of the the section called “Shot Elements” in the shot

• the section called “Overview” -- The playback and audio controls for the shot element

• the section called “Overview” -- The Build-In and Build-Out motion of the shot element

Audio

To change audio information in a shot, you must first the section called “Overview” then select a Audio
from the the section called “Shot Elements” list.

Audio. 

Each shot can have a piece of audio media as a part of the shot.

For example, you may choose to put an MP3 of a choral piece in the Audio shot element of a shot. Whenever
the shot becomes Live, the choral piece will play (mixed with what ever else is playing).

Available Panels. 

The Audio the section called “Shot Elements”, offers the following panels for editing:

• the section called “Overview” -- The media for the shot element

• the section called “Overview” -- The playback and audio controls for the shot element

Channel A/B/C

To change channel information in a shot, you must first the section called “Overview”, then select a Chan-
nel (A, B, or C) from the the section called “Shot Elements” list.
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Channels. 

A Channel contains the media for a part of a the section called “Scene”.

This allows you to assign, for example, different motion to each channel in a scene.

If a channel is "dimmed" or "ghosted" this means that the channel is not currently available in the Scene.
Only some Scenes contain all three channels, for example.

Available Panels. 

The Channel the section called “Shot Elements”, offers the following panels for editing:

• the section called “Overview” -- The media for the shot element

• the section called “Overview” -- Position, crop, etc, of the the section called “Shot Elements” in the shot

• the section called “Overview” -- The playback and audio controls for the shot element

• the section called “Overview” -- The Build-In and Build-Out motion of the shot element

• the section called “Overview” -- Chroma Key settings for this media
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Chapter 17. Edit: Scene
Overview

Accessing the Scene Panel. 

The Scene panel is available when you are the section called “Overview” and you have selected the Scene
the section called “Shot Elements”. It looks like this:

Scenes and Media. 

• the section called “Scene Selection” is on the left of the Scene tab.

Changing the scene changes what the section called “Channels” are in the scene; and changes where
those channels appear.

• the section called “Media Selection” is on the right of the Scene tab.

Here you select the media to be used in the scene.

Scene Selection

The Scene Selector. 

The left side of the the section called “Overview” is shown below, and you click on a scene to use it. Here
"Full-screen View" is selected:
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How to change the Scene. 

Simply click on another scene in the scene list. Here is what the window would like like if you clicked
on "Two Views":

How do I change the B? 

See the section called “Media Selection” for details on changing media in a scene.

Scene Filters. 
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The scene filter allows you to shown only scenes that accept a certain media count.

For example, if you only want to use two pieces of media, you can filter by "Two" and only those scenes
which use 2 pieces of media will be shown.

Media Selection

The Media Selector. 

The right side of the the section called “Overview” is shown below, and it is here that you select media
for the scene.

Channels and Scenes. 

Scenes can contain up to three the section called “Channels”.

To assign media to a particular channel in a Scene, you must select the channel and then click on the media.

Channel Selector. 

The channel selector looks like this (currently "A" is selected):

Changing Channel B. 

To change the media on Channel B, select Channel B, as shown below:

Then click on a piece of media (in our example, we clicked on "river"):
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If you had selected "Two Views" as shown in the section called “Scene Selection”, then your window
would look like this:

Channels

Definition. 

A channel is a place where media can exist in a the section called “Overview”.

Think of them as place-holders in the scene for media.

How are channels used in Wirecast? 

Today, channels are only used as place-holders in a Scene. In the future, this concept may be expanded.
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Editing Channels. 

At the bottom area of the the section called “Shot Elements” area, you will find three elements "Channel
A", "Channel B" and "Channel C".

When you select these shot elements, you are able to control the channel by using these panels:

• the section called “Overview” -- the media on the channel (yes, another way to select the media)

• the section called “Overview” -- Some of the effects settings (not all of them)

• the section called “Overview” -- Playback settings

• the section called “Overview” -- How the channel moves

• the section called “Overview” -- Chroma Key settings for the channel

Editing Restrictions. 

As of version 2 of Wirecast, it is not possible to edit some settings on the Effects panel.
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Chapter 18. Edit: Title
See Titling Capabilities

the section called “Overview”
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Chapter 19. Edit: Media
Overview

Accessing the Media Panel. 

The Media panel is available when you are the section called “Overview” and you have selected one of
the following the section called “Shot Elements”: Foreground, Background, Audio, or Channel A,B,C.

In the example shown below, we are editing the "Ripples" shot and have selected the Foreground element.
There is no media selected in this example.

More information. 

• the section called “Selecting Media” -- how to change the media

• the section called “Add / Remove media” -- how to add and remove media

Selecting Media

Selecting Media. 

You simply click on the media shown in the list to select it.

In the example below, we have selected the "logo.png" image.

Notice that the logo appears in the middle of the preview.
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Add / Remove media

The Media Panel. 

This is what the media panel looks like:
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Add using Drag and Drop. 

You can drag and drop media on to the media list (the light blue area as seen above).

Add using Add button. 

The

button can be used to add media.

Remove using Remove button. 

The

button can be used to remove media.



Wirecast 110 Telestream, Inc.

Chapter 20. Edit: Effects
Overview

Accessing the Effects panel. 

The Effects panel is available when you are the section called “Overview” and you have selected one of
the following the section called “Shot Elements”: Title, Foreground, Background, or Channel A,B,C.

In the example shown below, we are editing the "Ripples" shot and have selected the Foreground element.

Position

Position. 

Pressing the Position buttons (arrows) allows you to quickly control the position of the media inside of
the broadcast boundary.

In the example below, Position has been applied to the "logo.png" image.
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Using the mouse. 

In addition, you can move, scale, and rotate the image using the mouse:

• Move Media -- Use the mouse in the Preview area.

• Resize Respect Aspect -- Hold the command key while moving the mouse in the Preview area.

• Resize Media -- Turn off the section called “Respect Aspect Ratio”. Hold the shift-command key while
moving the mouse in the Preview area.

• Rotate Media -- Hold the option key while moving the mouse in the Preview area.

Opacity

Changing the Opacity. 

The opacity control can be found on the right side of the the section called “Overview”.

It is the first slider shown here:
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What is Opacity? 

Opacity controls how much you can "see through" the media.

Note
If you want to turn off the media altogether, don't set Opacity to zero, as this still uses CPU. You
should turn off the visibility of the the section called “Shot Elements”.

Isn't that Transparency? 

Strictly speaking transparency means to completely see through an object. In this case, we can partially
see through the object, so it's called Opacity (or how Opaque the object is).

Matte

What is a Matte? 

A matte is an image that is used to define the opacity of another piece of media.

Wirecast comes with several mattes, which are in the matte popup, shown here:

Using a Matte. 

Choose the desired matte from the popup.

Below is an example of the "Oval" matte:
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Using your own Matte. 

Any image which has an "alpha" channel will also show up in the Matte Popup.

Respect Aspect Ratio

Respecting the Aspect Ratio. 

The Respect Aspect Ratio control can be found on the right side of the the section called “Overview”.

It is the checkbox shown on the bottom right:

What elements allow turning off Respect Aspect Ratio. 

Only some the section called “Shot Elements” allow you to set this option.

Reset / Scale To Fit / Flip

Reset Position. 
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Pressing the Reset Position button forces the media to be reset to its original position, size, rotation.

Scale to Fit. 

Pressing the Scale to Fit button forces the media to be scaled to fit inside of the broadcast boundary.

In the example below, Scale To Fit has been applied to the "logo.png" image.

Horizontal Flip. 

Pressing the Scale to Fit button will flip the media horizontally.

This is equivalent to rotating the image by 180 degrees horizontally.

Cropping

Cropping media. 

The cropping controls can be found at the bottom of the the section called “Overview”.

There are four sliders/text boxes that control cropping, shown here:

An example. 

Below is an example with the left cropped by 300 pixels and the bottom cropped by 100 pixels
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Chapter 21. Edit: Playback
Overview

Accessing the Playback Panel. 

The Playback panel is available when you are the section called “Overview” and you have selected one of
the following the section called “Shot Elements”: Foreground, Background, Audio, or Channel A,B,C.

In the example shown below, we are editing the "Movie" shot and have selected the Channel A shot
element.

Movies and Music. 

This panel allows you to control how movies and music play in Wirecast.

You can control, for example, where in the movie or music Wirecast should the section called “In / Out
Points”, whether the movie should the section called “When Finished”, when it is done playing, etc.

Here is more information on the different parts of the Playback Panel:

• the section called “Live Playback” -- controls whether your changes affect the Live Broadcast

• the section called “Playing / Scrubbing” -- controlling the start and stop

• the section called “In / Out Points” -- controls where in the media to start and stop playing

• the section called “When Finished” -- what to do when the media is finished (loop/hold/remove)
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• the section called “Begin Playing” -- does the media automatically starts playing when it becomes live

• the section called “Remember Position” -- does the media remember its position when it is not live

• the section called “Audio” -- Volume, Mute, etc

Media which has Playback. 

The playback panel will only allow modification of parameters on media for which the options are possible.

For example, if your media has no audio, then the audio controls will not be active.

A more common example is if your media is not temporal (has no time). For example, if you have a still
image, you won't be able to set the In point or Output or "play" the image.

Scope. 

The Playback panel information is stored in the Shot itself.

This means that when you, say, the section called “In / Out Points” you are only setting the in point in
the shot you are editing.

If that media exists in a different shot, or even exists in the same shot but in a different the section called
“Shot Elements” your changes will not be applied there.

Live Playback

Live Playback is a part of the the section called “Overview” settings.

The affect of changes in the Playback Panel. 

By default, changes in the Playback panel are like any other changes in the Shot Editor -- they do not take
affect until you press the the section called “Transitions / Time / Go ”.

However, there are times when you may want to the section called “Playing / Scrubbing” and see the
scrubbing in the Live broadcast.

Making your changes Live. 

By checking the "Live Playback" checkbox as shown above, the changes you make in the Playback panel
become live.

This gives you fine tune control over the movie or audio in the Live broadcast.

Note
If you want to pause all movies in your broadcast, you can select "Pause All Movies" from the
"Media" menu. This is quite useful if you only have one movie and you wish to quickly pause it.

Playing / Scrubbing

Playing / Scrubbing is a part of the the section called “Overview” settings.

It is important to understand the the section called “Live Playback” option as it is directly related to what
the transport controls affect.
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Scrubbing. 

The above slider allows you "scrub" back and forth through your media.

The part you can move is called the "playhead".

To use this control, click inside the control and, while holding the mouse button down, move the mouse
left and right.

If the section called “Live Playback” is on, and the shot you are editing is live, then the scrubbing will
also be shown in your Live broadcast.

Setting the In Point and Out Point. 

The primary usage of being able to move the Playhead is to set the the section called “In / Out Points”.

Playing / Transport controls. 

The buttons shown above allow you to Rewind, Play, Pause, and Fast Forward, respectively.

If the section called “Live Playback” is on, then pressing the Pause button will pause the media in your
broadcast, and so forth.

In / Out Points

The In / Out Point controls are a part of the the section called “Overview” settings.

What is the In Point. 

The In Point is the position in the media where playback will start from.

For example, if you set the In Point of a movie to 2 seconds, then whenever the movie starts to play (or
loops back to the "start"), it will start from 2 seconds into the movie.

What is the Out Point. 

The Out Point is the position in the media where playback will end.

For example, if you set the Out Point of a movie to 2 minutes, then whenever the movie gets to the 2
minute mark, it will loop or stop playing (depending on the the section called “When Finished” options
you have set.

An Example. 

Imagine you have set the In Point to 5 Minutes and the Out Point to 7 Minutes and set the section called
“When Finished” to "Loop".
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In this case, then when the movie first becomes Live, it will start playing from the 5 minute mark in the
movie.

It will continue to play until it hits the 7 minute mark (it will have played for 2 minutes).

Then it will perform the Loop action, and return back to the 5 minute mark and start playing again.

You would move the playhead to a place you want the media to start, and then press the "Set" button to
set the In point to that point. See the section called “In / Out Points” for more information.

Setting the In Point. 

To set the In Point, you have to the section called “Playing / Scrubbing” to the point in the media you
wish the In Point to be.

Then you press the first Set button, as shown above.

Setting the Out Point. 

To set the Out Point, you have to the section called “Playing / Scrubbing” to the point in the media you
wish the Out Point to be.

Then you press the second Set button, as shown above.

Jump. 

Pressing the Jump button will move the playhead to the In Point or Out Point.

Time Strings. 

Both the In Point and Out Point show the time which the point represents.

In the example shown above, the In Point is at 5 minutes and 20 seconds into the movie. The Out Point
is at 1 hour, 39 minutes and 5 seconds.

When Finished

The When Finished options are a part of the the section called “Overview” settings.

When Finished. 

You can control what happens when the media finishes playing (when it reaches the the section called
“In / Out Points”)

You have 3 options:

• Loop -- the media will loop back to the the section called “In / Out Points”

• Hold -- the media will simply stop and show the last frame
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• Remove -- the media is removed from Live

Audio-only media. 

For media with no video, the Hold and Remove are effectively the same option.

Begin Playing

The Being Playing checkbox is a part of the the section called “Overview” settings.

Definition. 

Controls whether the media should start playing when the shot becomes Live.

When Begin Playing is on (checked). 

When this checkbox is checked, when the shot becomes live it will start playing this media.

When Begin Playing is off (un-checked). 

When this checkbox is not checked, when the shot becomes live it will not start playing this media.

Default. 

This checkbox is on by default, meaning that media will start playing when the shot becomes live.

Remember Position

The Remember Position checkbox is a part of the the section called “Overview” settings.

Definition. 

This option only controls what happens when a shot has been playing in Live and you transition to another
shot which does not contain the same media.

Controls whether the shot remembers the last position it was played the media.

When Remember Position is on (checked)... 

When Remember Position is on, the last position is remembered. When the shot becomes live again, it
will start playing from that position.

When Remember Position is off (un-checked)... 

When Remember Position is off, the position is not remembered. When the shot becomes live again, the
media will start playing from the the section called “In / Out Points”.

Default. 

This checkbox is on by default; the position will be remembered when the shot is no longer live.
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Audio

Controlling Audio of your media. 

If a piece of media has audio in it, then the above control will be activated.

Each piece of media can have the audio independently controlled.

The slider bar to the right of the audio meter allows you to control the volume of the media.

Muting the media for your viewers. 

If you want the media to not play any audio for your viewers ("mute"), then click on this button:

Muting the media for you, the operator. 

If you want your users to continue hearing the media, but you want to mute it for your headphones (or
your speakers), then press this button:
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Chapter 22. Edit: Motion
Overview

Accessing the Motion Panel. 

The Motion panel is available when you are the section called “Overview” and you have selected one of
the following the section called “Shot Elements”: Title, Foreground, Background, or Channel A,B,C.

In the example shown below, we are editing the "Ripples" shot and have selected Motion for the Fore-
ground element.

Motion only occurs for Smooth transition. 

Wirecast only ever performs motion when you are performing a "Smooth" the section called “Transitions /
Time / Go ”.

If you are performing another transition, the Motion settings are ignored.

Build In and Build Out. 

There are two types of motion:

• the section called “Build In” -- occurs when the element is entering the Live broadcast

• the section called “Build In” -- occurs when the element is leaving the Live broadcast

Motion only occurs when the object needs to enter or leave the Live Broadcast. 
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If you have two shots which have a Foreground, and the media in the Foreground is the same, then a
"Smooth" operation is performed between the foregrounds. The Motion is not performed.

For example, if the logo.png is the section called “Overview” in the top left in the old shot, and it's in the
bottom right in the new shot, then when you make the new shot Live, the logo.png will actually smooth
from the top-left corner to the bottom-right corner. The Build-In and Build-Out are ignored.

However, if you have two shots which have a Foreground, but the media is different, then the Build-Out
will be run for the old shot, and the Built-In will be run for the New shot.

Build In

Build In. 

Build In is a part of the the section called “Overview” settings.

The Build In motion occurs when the shot element is not in Live and will become Live. It only occurs
when the Smooth the section called “Transitions / Time / Go ” is active.

Here is what the Build In controls look like:

From ... . 

The Popup controls where the motion begins.

For example, if you select "From Left" then the motion will begin from just to the left of the visible area
of the broadcast.

Fade In. 

Controls whether the shot element should fade in.

If Fade In is unchecked, the element will "pop" into the Live, much like a Cut.

Spin In. 

The shot element is spun into position.

Scale In. 

The shot element is scaled in.

Decelerate In. 

All of the above actions are done performed in a way that makes them appear to slow down.

Build Out

Build Out. 
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Build Out is a part of the the section called “Overview” settings.

The Build Out motion occurs when the shot element is in Live and after the transition will not be. It only
occurs when the Smooth the section called “Transitions / Time / Go ” is active.

Here is what the Build Out controls look like:

To ... . 

The Popup controls where the motion ends.

For example, if you select "To Left" then the motion will begin wherever the object happens to be and end
just off to the left of the visible area of the broadcast.

Fade Out. 

Controls whether the shot element should fade out.

If Fade Out is unchecked, the element will "pop" out of Live, much like a Cut.

Spin Out. 

The shot element is spun out of position.

Scale Out. 

The shot element is scaled out.

Accelerate Out. 

All of the above actions are done performed in a way that makes them appear to speed up.

Apply to All

Apply To All is a part of the the section called “Overview” settings.

Apply to All. 

Makes the Motion Settings the same for all shot elements in this shot.

This is useful if you want to make all of your motion the same for all of the elements in the shot.
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Chapter 23. Edit: Chroma Key
Overview

Overview. 

Wirecast can now do real-time Chroma Key on your source.

You can use this feature only on a channel of a shot.

In the example below, we have edited a shot and selected the sample image "chroma_key.jpg" from the
media list.

See the section called “Media Selection” for information on how to select media.

Configuration

Turning on Chroma Key. 

The first thing to do is turn on the Chroma Key (a frame of your image is processed and defaults are
applied):
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Working top down. 

The Chroma Key configuration panel is designed to for you to work from top to bottom, fine tuning your
key as you go.

They biggest trick is to not "over-do it" on any one option. Getting a good key is about finding the right
balance.

Selecting a key color. 

So the very first thing you should do is select "Pick key color with mouse"

The "key color" is the color of the background you wish to "drop out" of the resulting media.

Make sure you get the best key possible by just selecting the key color before doing anything else.

Usually, clicking near the corners of the media gets the best key, but sometimes clicking near the subject
gets the best key.

Key Threshold. 

Once you have the best key by just picking the color, try adjusting the key threshold to drop out the
background.

This parameter tells Wirecast how "close of a color" to the color you've chosen as the "key color" to allow
to be "keyed" as well.

Black clip. 

Oftentimes, dark areas are keyed out when they should not be (this has to do with how digital cameras
work)
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This parameter controls how close to "black" to not key out.

If you have black hair, you'll most likely want o move this up a little bit.

White clip. 

Oftentimes, white areas are keyed out when they should not be (this has to do with how digital cameras
work)

This parameter controls how close to "white" to not key out.

If you have a white shirt on, you'll most likely want o move this up a little bit.

Getting a good key

In General. 

Probably the most important part of getting a good key is getting good source material.

Poor source material will generate poor keys; no algorithm can make up for this fact.

The better source material you have the easiest time you'll have dealing with any chroma key system.

Lighting. 

Assuming a reasonable camera, the most important part of getting a good key is good lighting.

If you buy anything else, buy some good lights and learn to set them up properly.

Here are some basics:

• The background green/blue screen needs to be independently lit from the talent.

• Evenly light the green-screen (no shadows). The more evenly lit, the better.

• Light the talent evenly (no shadows). A fill light is very important (use a white board in an office)

Good Camera. 

You should be able to get reasonable quality out of most reasonable cameras out there.

We have purposely purchased and tested with a low end DV camera to verify the quality of the key, but
of course the better camera you have the better.

A cheap USB Web-cam will not give you enough source quality to get a reasonable key.

If you have excellent lighting, an iSight will work well.

3 CCD is better than 1 CCD, web cams will have poorer quality keying (some are just not usable, others
passable, depending on your needs).

If you have the choice, a PAL camera is better than NTSC, due to how data is, internally, captured.

Capture Device Size. 

In the the section called “Advanced”, try changing the Capture Device size to "Native"

This gives much more data to the chroma key and allows for a better key, in general.
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The trade-off is performance (more data means more to do when keying). But it's generally worth the
tradeoff.

Note
If you use "Native" you must use Blend for deinterlacing.

High Quality Video. 

if you are keying video (from disk, not capturing live), you should make sure that this option is checked
in the the section called “Advanced” panel.

This tells Wirecast to decode the video from disk in the best quality possible thus giving the Chroma Key
the best data possible to key from.

Wirecast will warn you if High Quality Video is off and you attempt to turn on Chroma Key.



Wirecast 129 Telestream, Inc.

Chapter 24. Acknowledgments
Overview

Portions of this software may utilize the following copyrighted material, the use of which is hereby ac-
knowledged:

• the section called “Darwin Streaming Server”

• the section called “FFmpeg Project”

Darwin Streaming Server

APPLE PUBLIC SOURCE LICENSE
Version 2.0 - August 6, 2003
Please read this License carefully before downloading this software.
By downloading or using this software, you are agreeing to be bound by
the terms of this License. If you do not or cannot agree to the terms
of this License, please do not download or use the software.
1. General; Definitions. This License applies to any program or other
work which Apple Computer, Inc. ("Apple") makes publicly available and
which contains a notice placed by Apple identifying such program or
work as "Original Code" and stating that it is subject to the terms of
this Apple Public Source License version 2.0 ("License"). As used in
this License:
1.1 "Applicable Patent Rights" mean: (a) in the case where Apple is
the grantor of rights, (i) claims of patents that are now or hereafter
acquired, owned by or assigned to Apple and (ii) that cover subject
matter contained in the Original Code, but only to the extent
necessary to use, reproduce and/or distribute the Original Code
without infringement; and (b) in the case where You are the grantor of
rights, (i) claims of patents that are now or hereafter acquired,
owned by or assigned to You and (ii) that cover subject matter in Your
Modifications, taken alone or in combination with Original Code.
1.2 "Contributor" means any person or entity that creates or
contributes to the creation of Modifications.
1.3 "Covered Code" means the Original Code, Modifications, the
combination of Original Code and any Modifications, and/or any
respective portions thereof.
1.4 "Externally Deploy" means: (a) to sublicense, distribute or
otherwise make Covered Code available, directly or indirectly, to
anyone other than You; and/or (b) to use Covered Code, alone or as
part of a Larger Work, in any way to provide a service, including but
not limited to delivery of content, through electronic communication
with a client other than You.
1.5 "Larger Work" means a work which combines Covered Code or portions
thereof with code not governed by the terms of this License.
1.6 "Modifications" mean any addition to, deletion from, and/or change
to, the substance and/or structure of the Original Code, any previous
Modifications, the combination of Original Code and any previous
Modifications, and/or any respective portions thereof. When code is
released as a series of files, a Modification is: (a) any addition to
or deletion from the contents of a file containing Covered Code;



Acknowledgments

Wirecast 130 Telestream, Inc.

and/or (b) any new file or other representation of computer program
statements that contains any part of Covered Code.
1.7 "Original Code" means (a) the Source Code of a program or other
work as originally made available by Apple under this License,
including the Source Code of any updates or upgrades to such programs
or works made available by Apple under this License, and that has been
expressly identified by Apple as such in the header file(s) of such
work; and (b) the object code compiled from such Source Code and
originally made available by Apple under this License.
1.8 "Source Code" means the human readable form of a program or other
work that is suitable for making modifications to it, including all
modules it contains, plus any associated interface definition files,
scripts used to control compilation and installation of an executable
(object code).
1.9 "You" or "Your" means an individual or a legal entity exercising
rights under this License. For legal entities, "You" or "Your"
includes any entity which controls, is controlled by, or is under
common control with, You, where "control" means (a) the power, direct
or indirect, to cause the direction or management of such entity,
whether by contract or otherwise, or (b) ownership of fifty percent
(50%) or more of the outstanding shares or beneficial ownership of
such entity.
2. Permitted Uses; Conditions & Restrictions. Subject to the terms
and conditions of this License, Apple hereby grants You, effective on
the date You accept this License and download the Original Code, a
world-wide, royalty-free, non-exclusive license, to the extent of
Apple's Applicable Patent Rights and copyrights covering the Original
Code, to do the following:
2.1 Unmodified Code. You may use, reproduce, display, perform,
internally distribute within Your organization, and Externally Deploy
verbatim, unmodified copies of the Original Code, for commercial or
non-commercial purposes, provided that in each instance:
(a) You must retain and reproduce in all copies of Original Code the
copyright and other proprietary notices and disclaimers of Apple as
they appear in the Original Code, and keep intact all notices in the
Original Code that refer to this License; and
(b) You must include a copy of this License with every copy of Source
Code of Covered Code and documentation You distribute or Externally
Deploy, and You may not offer or impose any terms on such Source Code
that alter or restrict this License or the recipients' rights
hereunder, except as permitted under Section 6.
2.2 Modified Code. You may modify Covered Code and use, reproduce,
display, perform, internally distribute within Your organization, and
Externally Deploy Your Modifications and Covered Code, for commercial
or non-commercial purposes, provided that in each instance You also
meet all of these conditions:
(a) You must satisfy all the conditions of Section 2.1 with respect to
the Source Code of the Covered Code;
(b) You must duplicate, to the extent it does not already exist, the
notice in Exhibit A in each file of the Source Code of all Your
Modifications, and cause the modified files to carry prominent notices
stating that You changed the files and the date of any change; and
(c) If You Externally Deploy Your Modifications, You must make
Source Code of all Your Externally Deployed Modifications either
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available to those to whom You have Externally Deployed Your
Modifications, or publicly available. Source Code of Your Externally
Deployed Modifications must be released under the terms set forth in
this License, including the license grants set forth in Section 3
below, for as long as you Externally Deploy the Covered Code or twelve
(12) months from the date of initial External Deployment, whichever is
longer. You should preferably distribute the Source Code of Your
Externally Deployed Modifications electronically (e.g. download from a
web site).
2.3 Distribution of Executable Versions. In addition, if You
Externally Deploy Covered Code (Original Code and/or Modifications) in
object code, executable form only, You must include a prominent
notice, in the code itself as well as in related documentation,
stating that Source Code of the Covered Code is available under the
terms of this License with information on how and where to obtain such
Source Code.
2.4 Third Party Rights. You expressly acknowledge and agree that
although Apple and each Contributor grants the licenses to their
respective portions of the Covered Code set forth herein, no
assurances are provided by Apple or any Contributor that the Covered
Code does not infringe the patent or other intellectual property
rights of any other entity. Apple and each Contributor disclaim any
liability to You for claims brought by any other entity based on
infringement of intellectual property rights or otherwise. As a
condition to exercising the rights and licenses granted hereunder, You
hereby assume sole responsibility to secure any other intellectual
property rights needed, if any. For example, if a third party patent
license is required to allow You to distribute the Covered Code, it is
Your responsibility to acquire that license before distributing the
Covered Code.
3. Your Grants. In consideration of, and as a condition to, the
licenses granted to You under this License, You hereby grant to any
person or entity receiving or distributing Covered Code under this
License a non-exclusive, royalty-free, perpetual, irrevocable license,
under Your Applicable Patent Rights and other intellectual property
rights (other than patent) owned or controlled by You, to use,
reproduce, display, perform, modify, sublicense, distribute and
Externally Deploy Your Modifications of the same scope and extent as
Apple's licenses under Sections 2.1 and 2.2 above.
4. Larger Works. You may create a Larger Work by combining Covered
Code with other code not governed by the terms of this License and
distribute the Larger Work as a single product. In each such instance,
You must make sure the requirements of this License are fulfilled for
the Covered Code or any portion thereof.
5. Limitations on Patent License. Except as expressly stated in
Section 2, no other patent rights, express or implied, are granted by
Apple herein. Modifications and/or Larger Works may require additional
patent licenses from Apple which Apple may grant in its sole
discretion.
6. Additional Terms. You may choose to offer, and to charge a fee for,
warranty, support, indemnity or liability obligations and/or other
rights consistent with the scope of the license granted herein
("Additional Terms") to one or more recipients of Covered Code.
However, You may do so only on Your own behalf and as Your sole
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responsibility, and not on behalf of Apple or any Contributor. You
must obtain the recipient's agreement that any such Additional Terms
are offered by You alone, and You hereby agree to indemnify, defend
and hold Apple and every Contributor harmless for any liability
incurred by or claims asserted against Apple or such Contributor by
reason of any such Additional Terms.
7. Versions of the License. Apple may publish revised and/or new
versions of this License from time to time. Each version will be given
a distinguishing version number. Once Original Code has been published
under a particular version of this License, You may continue to use it
under the terms of that version. You may also choose to use such
Original Code under the terms of any subsequent version of this
License published by Apple. No one other than Apple has the right to
modify the terms applicable to Covered Code created under this
License.
8. NO WARRANTY OR SUPPORT. The Covered Code may contain in whole or in
part pre-release, untested, or not fully tested works. The Covered
Code may contain errors that could cause failures or loss of data, and
may be incomplete or contain inaccuracies. You expressly acknowledge
and agree that use of the Covered Code, or any portion thereof, is at
Your sole and entire risk. THE COVERED CODE IS PROVIDED "AS IS" AND
WITHOUT WARRANTY, UPGRADES OR SUPPORT OF ANY KIND AND APPLE AND
APPLE'S LICENSOR(S) (COLLECTIVELY REFERRED TO AS "APPLE" FOR THE
PURPOSES OF SECTIONS 8 AND 9) AND ALL CONTRIBUTORS EXPRESSLY DISCLAIM
ALL WARRANTIES AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF
MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR
PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND NONINFRINGEMENT OF THIRD
PARTY RIGHTS. APPLE AND EACH CONTRIBUTOR DOES NOT WARRANT AGAINST
INTERFERENCE WITH YOUR ENJOYMENT OF THE COVERED CODE, THAT THE
FUNCTIONS CONTAINED IN THE COVERED CODE WILL MEET YOUR REQUIREMENTS,
THAT THE OPERATION OF THE COVERED CODE WILL BE UNINTERRUPTED OR
ERROR-FREE, OR THAT DEFECTS IN THE COVERED CODE WILL BE CORRECTED. NO
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE, AN APPLE
AUTHORIZED REPRESENTATIVE OR ANY CONTRIBUTOR SHALL CREATE A WARRANTY.
You acknowledge that the Covered Code is not intended for use in the
operation of nuclear facilities, aircraft navigation, communication
systems, or air traffic control machines in which case the failure of
the Covered Code could lead to death, personal injury, or severe
physical or environmental damage.
9. LIMITATION OF LIABILITY. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO
EVENT SHALL APPLE OR ANY CONTRIBUTOR BE LIABLE FOR ANY INCIDENTAL,
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING
TO THIS LICENSE OR YOUR USE OR INABILITY TO USE THE COVERED CODE, OR
ANY PORTION THEREOF, WHETHER UNDER A THEORY OF CONTRACT, WARRANTY,
TORT (INCLUDING NEGLIGENCE), PRODUCTS LIABILITY OR OTHERWISE, EVEN IF
APPLE OR SUCH CONTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES AND NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY
REMEDY. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY
TO YOU. In no event shall Apple's total liability to You for all
damages (other than as may be required by applicable law) under this
License exceed the amount of fifty dollars ($50.00).
10. Trademarks. This License does not grant any rights to use the



Acknowledgments

Wirecast 133 Telestream, Inc.

trademarks or trade names "Apple", "Apple Computer", "Mac", "Mac OS",
"QuickTime", "QuickTime Streaming Server" or any other trademarks,
service marks, logos or trade names belonging to Apple (collectively
"Apple Marks") or to any trademark, service mark, logo or trade name
belonging to any Contributor. You agree not to use any Apple Marks in
or as part of the name of products derived from the Original Code or
to endorse or promote products derived from the Original Code other
than as expressly permitted by and in strict compliance at all times
with Apple's third party trademark usage guidelines which are posted
at http://www.apple.com/legal/guidelinesfor3rdparties.html.
11. Ownership. Subject to the licenses granted under this License,
each Contributor retains all rights, title and interest in and to any
Modifications made by such Contributor. Apple retains all rights,
title and interest in and to the Original Code and any Modifications
made by or on behalf of Apple ("Apple Modifications"), and such Apple
Modifications will not be automatically subject to this License. Apple
may, at its sole discretion, choose to license such Apple
Modifications under this License, or on different terms from those
contained in this License or may choose not to license them at all.
12. Termination.
12.1 Termination. This License and the rights granted hereunder will
terminate:
(a) automatically without notice from Apple if You fail to comply with
any term(s) of this License and fail to cure such breach within 30
days of becoming aware of such breach;
(b) immediately in the event of the circumstances described in Section
13.5(b); or
(c) automatically without notice from Apple if You, at any time during
the term of this License, commence an action for patent infringement
against Apple; provided that Apple did not first commence
an action for patent infringement against You in that instance.
12.2 Effect of Termination. Upon termination, You agree to immediately
stop any further use, reproduction, modification, sublicensing and
distribution of the Covered Code. All sublicenses to the Covered Code
which have been properly granted prior to termination shall survive
any termination of this License. Provisions which, by their nature,
should remain in effect beyond the termination of this License shall
survive, including but not limited to Sections 3, 5, 8, 9, 10, 11,
12.2 and 13. No party will be liable to any other for compensation,
indemnity or damages of any sort solely as a result of terminating
this License in accordance with its terms, and termination of this
License will be without prejudice to any other right or remedy of
any party.
13. Miscellaneous.
13.1 Government End Users. The Covered Code is a "commercial item" as
defined in FAR 2.101. Government software and technical data rights in
the Covered Code include only those rights customarily provided to the
public as defined in this License. This customary commercial license
in technical data and software is provided in accordance with FAR
12.211 (Technical Data) and 12.212 (Computer Software) and, for
Department of Defense purchases, DFAR 252.227-7015 (Technical Data --
Commercial Items) and 227.7202-3 (Rights in Commercial Computer
Software or Computer Software Documentation). Accordingly, all U.S.
Government End Users acquire Covered Code with only those rights set
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forth herein.
13.2 Relationship of Parties. This License will not be construed as
creating an agency, partnership, joint venture or any other form of
legal association between or among You, Apple or any Contributor, and
You will not represent to the contrary, whether expressly, by
implication, appearance or otherwise.
13.3 Independent Development. Nothing in this License will impair
Apple's right to acquire, license, develop, have others develop for
it, market and/or distribute technology or products that perform the
same or similar functions as, or otherwise compete with,
Modifications, Larger Works, technology or products that You may
develop, produce, market or distribute.
13.4 Waiver; Construction. Failure by Apple or any Contributor to
enforce any provision of this License will not be deemed a waiver of
future enforcement of that or any other provision. Any law or
regulation which provides that the language of a contract shall be
construed against the drafter will not apply to this License.
13.5 Severability. (a) If for any reason a court of competent
jurisdiction finds any provision of this License, or portion thereof,
to be unenforceable, that provision of the License will be enforced to
the maximum extent permissible so as to effect the economic benefits
and intent of the parties, and the remainder of this License will
continue in full force and effect. (b) Notwithstanding the foregoing,
if applicable law prohibits or restricts You from fully and/or
specifically complying with Sections 2 and/or 3 or prevents the
enforceability of either of those Sections, this License will
immediately terminate and You must immediately discontinue any use of
the Covered Code and destroy all copies of it that are in your
possession or control.
13.6 Dispute Resolution. Any litigation or other dispute resolution
between You and Apple relating to this License shall take place in the
Northern District of California, and You and Apple hereby consent to
the personal jurisdiction of, and venue in, the state and federal
courts within that District with respect to this License. The
application of the United Nations Convention on Contracts for the
International Sale of Goods is expressly excluded.
13.7 Entire Agreement; Governing Law. This License constitutes the
entire agreement between the parties with respect to the subject
matter hereof. This License shall be governed by the laws of the
United States and the State of California, except that body of
California law concerning conflicts of law.
Where You are located in the province of Quebec, Canada, the following
clause applies: The parties hereby confirm that they have requested
that this License and all related documents be drafted in English. Les
parties ont exige que le present contrat et tous les documents
connexes soient rediges en anglais.
EXHIBIT A.
"Portions Copyright (c) 1999-2003 Apple Computer, Inc. All Rights
Reserved.
This file contains Original Code and/or Modifications of Original Code
as defined in and that are subject to the Apple Public Source License
Version 2.0 (the 'License'). You may not use this file except in
compliance with the License. Please obtain a copy of the License at
http://www.opensource.apple.com/apsl/ and read it before using this
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file.
The Original Code and all software distributed under the License are
distributed on an 'AS IS' basis, WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, AND APPLE HEREBY DISCLAIMS ALL SUCH WARRANTIES,
INCLUDING WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT OR NON-INFRINGEMENT.
Please see the License for the specific language governing rights and
limitations under the License."

FFmpeg Project

GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
Preamble
The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
Licenses are intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users.
This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about whether
this license or the ordinary General Public License is the better
strategy to use in any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and charge
for this service if you wish); that you receive source code or can get
it if you want it; that you can change the software and use pieces of
it in new free programs; and that you are informed that you can do
these things.
To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender these
rights. These restrictions translate to certain responsibilities for
you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we gave
you. You must make sure that they, too, receive or can get the source
code. If you link other code with the library, you must provide
complete object files to the recipients, so that they can relink them
with the library after making changes to the library and recompiling
it. And you must show them these terms so they know their rights.
We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.
To protect each distributor, we want to make it very clear that
there is no warranty for the free library. Also, if the library is
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modified by someone else and passed on, the recipients should know
that what they have is not the original version, so that the original
author's reputation will not be affected by problems that might be
introduced by others.
Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.
When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.
We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.
For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it becomes
a de-facto standard. To achieve this, non-free programs must be
allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.
In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
operating system, as well as its variant, the GNU/Linux operating
system.
Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter must
be combined with the library in order to run.
GNU LESSER GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
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0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of
this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".
A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.
The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)
"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation
and installation of the library.
Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based
on the Library (independent of the use of the Library in a tool for
writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.
1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library.
You may charge a fee for the physical act of transferring a copy,
and you may at your option offer warranty protection in exchange for a
fee.
2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no
charge to all third parties under the terms of this License.
d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses
the facility, other than as an argument passed when the facility
is invoked, then you must make a good faith effort to ensure that,
in the event an application does not supply such function or
table, the facility still operates, and performs whatever part of
its purpose remains meaningful.
(For example, a function in a library to compute square roots has
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a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must
be optional: if the application does not supply it, the square
root function must still compute square roots.)
These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.
Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.
In addition, mere aggregation of another work not based on the Library
with the Library (or with a work based on the Library) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.
3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version 2,
instead of to this License. (If a newer version than version 2 of the
ordinary GNU General Public License has appeared, then you can specify
that version instead if you wish.) Do not make any other change in
these notices.
Once this change is made in a given copy, it is irreversible for
that copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.
This option is useful when you wish to copy part of the code of
the Library into a program that is not a library.
4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange.
If distribution of object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the
source code from the same place satisfies the requirement to
distribute the source code, even though third parties are not
compelled to copy the source along with the object code.
5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled or
linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library
creates an executable that is a derivative of the Library (because it
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contains portions of the Library), rather than a "work that uses the
library". The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.
When a "work that uses the Library" uses material from a header file
that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be
linked without the Library, or if the work is itself a library. The
threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data
structure layouts and accessors, and small macros and small inline
functions (ten lines or less in length), then the use of the object
file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the
Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.
6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications.
You must give prominent notice with each copy of the work that the
Library is used in it and that the Library and its use are covered by
this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one
of these things:
a) Accompany the work with the complete corresponding
machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under
Sections 1 and 2 above); and, if the work is an executable linked
with the Library, with the complete machine-readable "work that
uses the Library", as object code and/or source code, so that the
user can modify the Library and then relink to produce a modified
executable containing the modified Library. (It is understood
that the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application
to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user's computer system,
rather than copying library functions into the executable, and (2)
will operate properly with a modified version of the library, if
the user installs one, as long as the modified version is
interface-compatible with the version that the work was made with.
c) Accompany the work with a written offer, valid for at
least three years, to give the same user the materials
specified in Subsection 6a, above, for a charge no more
than the cost of performing this distribution.
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d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.
e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.
For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.
It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.
7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on
the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the
Sections above.
b) Give prominent notice with the combined library of the fact
that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.
8. You may not copy, modify, sublicense, link with, or distribute
the Library except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, link with, or
distribute the Library is void, and will automatically terminate your
rights under this License. However, parties who have received copies,
or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.
9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.
10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the Library
subject to these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties with
this License.
11. If, as a consequence of a court judgment or allegation of patent
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infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Library at all. For example, if a patent
license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply,
and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.
12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those countries,
so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if
written in the body of this License.
13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time.
Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.
14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status
of all derivatives of our free software and of promoting the sharing
and reuse of software generally.
NO WARRANTY
15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
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WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.
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